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Using This Manual

Using This Manual

This User Manual provides detailed information on how to use all functions of
the Bode 100 vector network analyzer properly and efficiently. The Bode 100
User Manual is intended for all users of the Bode 100, providing instructions on
the operation, usage, and measurement procedures.

Any user of the Bode 7100 should have fundamental working knowledge of basic
electronics, general measurement techniques, and the use of computer-based
applications running under a Windows® environment.

Conventions and Symbols Used

In this manual, the following symbol indicates paragraphs with special safety
relevant meaning:

Symbol Description

Equipment damage or loss of data
possible

Related Documents

The following documents complete the information covered in the Bode 100
User Manual:

Title Description

Automation Interface Object Hierarchy Provide detailed information on the
and Automation Interface Reference Bode Analyzer Automation Interface.
(available in the Automation

subdirectory of the

Bode Analyzer Suite directory)
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Introduction

1 Introduction

1.1 Overview

The Bode 100 is a multifunctional test & measurement instrument designed for
professionals such as scientists, engineers and teachers engaged in the field of
electronics. Its concept — universal hardware controlled by the

Bode Analyzer Suite software running on a computer — makes the Bode 100 an
efficient and flexible solution for a wide spectrum of applications including:

* Gain/Phase measurements
The Bode 100 measures the gain and phase of passive and active electronic
circuits as well as complex electronic systems such as closed-loop control
systems, video systems and RF equipment.

* Impedance/Reflection measurements
The Bode 100 measures the impedance, admittance and reflection
coefficient of passive and active electronic circuits. An internal circuitry
facilitates performing measurements by just connecting the device under test
(DUT) to the Bode 100 source.

* Frequency Sweep measurements
In addition to single frequency measurements, the Bode 100 performs
measurements in the Frequency Sweep mode.
In this measurement mode, the Bode 100 is capable of measuring the
complex gain, reflection coefficient and impedance of the DUT. The results
are displayed as a function of the frequency in various display formats such
as group delay curves or Smith charts.

*  Frequency Sweep (External Coupler) measurements
In this measurement mode, you can measure the complex impedance,
admittance and reflection coefficient of the DUT by using an external
directional coupler or other external measurement bridge. Typical application
examples include measurements of broadcast antennas and impedance
measurements with signal levels above 20 mW.

* Frequency Sweep (Impedance Adapter) measurements
In this measurement mode, you can measure the impedance of wired
components and surface mounted components by using the B-WIC and
B-SMC impedance adapters (see 1.8 "Additional Accessories" on page 15)
respectively.

The measurement results are available on your computer for processing and/or
documentation.
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The Bode 100 includes a DDS (direct digital synthesis) signal source with
adjustable level and frequency for excitation of the DUT, two receivers
processing the DUT’s response and a microcontroller. A DC power converter
generates voltages for powering the circuitry involved. For the basic block
diagram of the Bode 100, see Figure 1-1: "Block diagram" on page 11.

The Bode Analyzer Suite runs on a computer connected to the Bode 100
through USB interface.
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1.2 Block Diagram

Figure 1-1:
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1.3 Connectors

Caution: To avoid damage of the Bode 700, check 13.3 "Absolute
Maximum Ratings" on page 182 for maximum input signals at the
INPUT CH 1 and INPUT CH 2 connectors and maximum reverse power at
the OUTPUT connector.

The Bode 100 provides the following connectors:

+ OUTPUT (signal source output) on the front panel
* INPUT CH 1 (channel 1 input) on the front panel
* INPUT CH 2 (channel 2 input) on the front panel

» DC power input on the rear panel

+ USB connector on the rear panel
Figure 1-2:

Bode 100 front view l

QUITPUT.___.

-

|
OUTPUT INPUTCH 1 INPUT CH 2
Figure 1-3:

Bode 100 rear view

) |
DC power input USB connector
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1.4 Standard Compliance

The Bode 100 complies with the following standards:

Table 1-1:
Standard compliance

Standard Description

EN/IEC 61326-1: EMC requirements
Class B equipment
Performance criterion B

EN/IEC 61010-1 Safety requirements

Universal Serial Bus (USB) Specification, |USB interface
Revision 1.1 and Revision 2.0

1.5 Normative Conformity

The Bode 100 conforms to the following normative documents of the EU:

Table 1-2:
Conformity documents

Document Description

LVD Directive |of the European Parliament and of the Council of
2006/95/EC 12 December 2006 on the harmonisation of the laws of
Member States relating to electrical equipment designed for
use within certain voltage limits (codified version)

EMC Directive | of the European parliament and of the council of
2004/108/EC |15 December 2004 on the approximation of the laws of the
Member States relating to electromagnetic compatibility and
repealing Directive 89/336/EEC

1.6 Test Compliance

The Bode 100 passed the tests according to the EN/IEC 61010-1, IEC 61326.

13
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1.7

Delivery

Bode 100 multifunctional
vector network analyzer

Bode 100 CD-ROM

Wide-range AC power
supply including mains
input plugs for different
national standards

Quartz Filter

Test objects on a PCB:
quartz filter, IF filter

USB cable

@

4 x BNC 50 Q cable
(m-m)

BNC straight adapter ()

BNC short circuit (m)

BNC 50 Q load (m)

Bode 100 User Manual

The delivered items
may differ slightly
from the picture.
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1.8 Additional Accessories

The following additional accessories are available for purchase from
OMICRON Lab.

B-WIC impedance B-SMC impedance B-WIT 100 broadband
adapter for through hole |adapter for surface injection transformer
type components mounted components

For information on using the B-WIC and B-SMC impedance adapters, see
7 "Frequency Sweep (Impedance Adapter) Mode" on page 79.

The B-WIT 100 broadband injection transformer is especially designated for
measurement of switched mode power supplies and control loops. For more
information on the possible applications of the B-WIT 100, refer to the
OMICRON Lab Web site www.omicron-lab.com.

15


http://www.omicron-lab.com

Bode 100 User Manual

This page intentionally left blank

16



B>

2.1

>

2.2

2.3

Getting Started

Getting Started

Caution: Before installing the Bode 100, check the environmental and
power requirements (see 13 "Technical Data" on page 181).

Installing the Bode Analyzer Suite

Caution: Install the Bode Analyzer Suite from the delivered CD-ROM
before connecting the Bode 7100 to the USB connector of your computer.

The Bode Analyzer Suite on the delivered CD-ROM controls the operation of the
Bode 100. Install the Bode Analyzer Suite first, before you connect the

Bode 100to the computer. Put the Bode 100 CD-ROM in the CD-ROM drive and
follow the instructions on the screen. Select the 32-bit or 64-bit installation
according to your computer’s hardware and operating system. For installation
support, visit the OMICRON Lab Web site www.omicron-lab.com or contact your
nearest support center (see "Contact Information / Technical Support" on

page 185).

Powering the Bode 100

Caution: Before powering the Bode 100 using a DC power supply different
from the one delivered with the Bode 100, check the polarity of its output
voltage (see 13.2 "Power Requirements" on page 182).

The Bode 100 is powered with an external wide-range AC power adapter.
Before powering the Bode 100, select the adapter’s mains input plug fitting your
power outlet. Plug the adapter’s DC output connector into the Bode 700 DC
power input on the rear panel and the mains input plug into the power outlet.
Alternatively, you can power the Bode 100 with any DC power supply meeting
the power requirements specified on page 182.

Connecting the Bode 100 to the Computer

The Bode 100 communicates with the computer through USB interface (see
13.4 "System Requirements" on page 183). Connect the Bode 100 USB
connector on the rear panel to the USB connector of your computer using the
USB cable delivered with your Bode 100.

17
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2.4

How to Proceed

Now, you are ready to work with your Bode 700. You can proceed with
Section 3 "Gain/Phase Mode" to make your first measurement with the
Bode 100, and then go through the Bode 100 User Manual to learn the
capabilities of your Bode 100 by doing practical examples. For the
Bode Analyzer Suite basics, see Section 9 "Common Functions".

18
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3 Gain/Phase Mode

Figure 3-1:
Gain/Phase mode Menu bar
window Allows access to all Bode 100 functions. See 9.1 "Toolbars, Menus and Commands" on page 117.
——Toolbar
Contains shortcuts to the most important
— Calibration and Bode 100 functions.
trace functions toolbar (disabled) See Figure 9-1: "Toolbar" on page 117.
Choose the calibration mode and Results

switch the calibration on and off.
Switch the trace functions on and off.
See Figure 9-2: "Calibration and
trace functions toolbar" on page 117.

Select the result format and get result values.
See Figure 3-3: "Gain/Phase mode results" on
page 20.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement Bode
File  Measurement  Configuration — Calbbration  Trace  Tools  Help ’

GEFIEEIETY DI I EEEE]

L (E:L User Calibration. . e % Probe Calibration, . T % )
/ﬁe \ Fresul \
Source Frequency | 12,000 MHz [tag [dB) = 10.983 B
Confiqustior [Frase) =l T2

Level 0.00 dEm / \
025

Attenuster CH1 |20 dB - ‘
Atterustor CH2 |20 dB - 2o0m Mo

020
opt
Receiver Bandwidth |1 kHz hd ptimize:
0.15 Reset Axes
Grid Folar
0.10
Copy
0.05 Copy with Settings
0.00
-0.05
-0.10
015

-0.2

Split bar
Drag the split bar to resize the panes.

Configuration and measurement setup Source, overload, and connection
See Figure 3-2: "Configuration and indicators
measurement setup” on page 20. See Figure 3-5: "Source, overload, and

connection indicators" on page 21.

Graphical display of measurement results
Use the shortcut menu to optimize the display.
See Figure 3-4: "Graphical display of measurement results" on page 21.
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Figure 3-2:
Configuration and S ource
measurement setup
Set the output source
Source Frequency 12.000 MHz — generator frequency.
Configuration
Set the output source
Lewvel | 0.00 I:IEh'l'l_generator level.
Select the channel 1
Attenuator CH1 |20 dB v | ——input attenuation.
Select the channel 2
Attenuator CH2 |20 dB * | ——input attenuation.
. . Select the receiver
Recerver Bandwidth | 1 kHz - |_bandwidth.

Hint: A higher receiver bandwidth allows faster measurements, a lower receiver
bandwidth increases the measurement accuracy.

Figure 3-3:

Gain/Phase mode

results Select the output format of
measurement results.

|Mag [dE] j | -1.545 dB Display of measurement
results in the selected
format.

|Phase ['] ~H] 28607 ™

20
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Figure 3-4:

Graphical display of

measurement results
0.06
0.05
0.04

0.03

0.02 Zoom Mode
Optimize
e Reset Axes

Copy
Copy with Settings

-0.01

-0.02

-0.02 0.00 0.02 0.04 0.06

Right-click in the diagram to open the shortcut menu.
Use the shortcut menu to optimize the diagram, select the grid and zoom in the
diagram. After having zoomed in, click Optimize to get back to an optimized diagram.

Hint: Using the Copy and Copy with Settings functions you can easily export
your diagram into other Windows® applications. For more information, see
10.1 "Advanced Display Options" on page 125.

Figure 3-5:
Source, overload, and Overload indicators for the channel 1 and channel 2 inputs. If you see a red bar, increase
connection indicators the attenuation of the respective channel or reduce the source level to prevent the overload.
I—I_I [ | [ Eepaorc |
Source indicator (see Serial number of the Bode 100

3.3 "Example: Gain/Phase

Hint: If the serial number field in the status bar displays No Device on red
background, check whether the Bode 7100 is powered and connected to your

computer, and then click the Search and Reconnect Device toolbar button =2
to reconnect the Bode 100.

21
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Basics

The gain and phase of the DUT is calculated from the measurement data
obtained using the reference channel 1 and the measurement channel 2. You
can connect the signal source to the reference channel internally or externally
as described in 3.2 "Choosing the Reference Connection" on page 24.

The basic definitions and formulas related to the gain/phase measurements are
summarized below:

(H(f)| = abs{H(f)} (Eq. 3-1)

o(N) = arg{H()} (Eq. 3-2)
= 1l gdyn_d -

Tg(f) - 7275 EJ,¢U) @d’(ﬁ)) (Eq 3 3)

where

H(f) ...displayed gain/phase function

|H(f)| ...magnitude of H(f)

o) ...phase of H(f)

T,(f) ...group delay of H(/)

ZOUT .

S.(f)y =2e ,i#] (Eq. 3-4)

Jt YO

Hy(f) = -7 (Eq. 3-5)
=IN

where

AY0)) ...S parameter from port j to portj (i =) of the DUT

H,(f) ...transfer function of a two-port device, H,(f) depends on the load of the
port where ¥, is measured

Vour ---voltage at the DUT’s output

v,  ...open-circuit voltage of the source

V,y -.-voltage at the DUT’s input

Ve ---voltage at the channel 1 input

Ve, ---voltage at the channel 2 input

Z, -.-inputimpedance of the DUT

Ry ...50 Q source resistance

Assumptions for measuring SN+

+ The source with resistance R, = 50 Q is connected to port .

+ 50 Q load (receiver resistance) at port j measuring v,

ur» any other ports of

the DUT are terminated with 50 Q.
» Connections are made with 50 Q cables.

22
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3.1.1 Internal Reference Connection

The basic formulas for the internal reference connection are summarized below.

Note: In the internal reference connection mode of the Bode 100, the reference
voltage for the gain/phase measurement is always V,/2.

Table 3-1:
Formulas for Internal
Reference Connection Channel 2 Input Resistance
50 Q High Impedance
—VO ZO
Vem = Y (EQ. 3-6)| Viyy = > (Eq. 3-7)
Yews = Your (EQ.3-8)| Yoy = Your (Eq. 3-9)
_ Zin
Vin=V,° (—Zl—m (Eq. 3-10)
Ve Your Ve Your
H(f) = =20 —— H(f) = =D e Yl
Vem Yy Vem Vo
= 5,(/) of the DUT (Eq. 3-11) [= g Lour, 2 (Eq. 3-12)

Vi (Ziy*Rg)

VA
H(f) = 2 Hy(f) s —=— (Eq. 3-13)

(Z;y+ Ry)
If you make a through connection If you make a through connection
from the source to CH 2: from the source to CH 2:
0 dB gain will be displayed since +6 dB gain will be displayed since

Vers = ¥y/2 Ve = ¥y

3.1.2 External Reference Connection

Independent of the selected input impedance at the channel 1 and channel 2
inputs, the following formulas apply:

Ve = Vi (Eq. 3-14)

Vewr = Your (Eq. 3-15)
V Vv

H(f) = H(f) = FCH2 _ Zour (Eq. 3-16)

ECHI L/IN

23
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3.2 Choosing the Reference Connection

Open the Configuration window by clicking Device Configuration on the
Configuration menu or the Device Configuration toolbar button %, (see
3.3 "Example: Gain/Phase Measurement" on page 26). By default, the
Device Configuration tab is selected.

To connect the reference internally, set the marked configuration field as shown
below.

Configuration PZ|

Device Configuration l Connection Setup ]

e £ futo RECEIVER 1 Receiver RECEIVER 2
10.720 MHz *+ On Bandwidth

@ o I 1 kHz = I

ATTH 1 ATTH 2

20de - DUT delay 20dE -
0.00 =

Measurement
period

3.06 mz

Internal
reference

SDQI:I

Lewvel

0.00 dBm

ouTPUT

QK | Cancel | Help

Note: The source signal is internally connected to the channel 1 input (CH1) in
front of the 50 Q source resistor (channel 1 voltage v, = ¥,/2 as defined in
3.1 "Basics" on page 22).

24
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To connect the reference externally:

1. Set the marked configuration field as shown in the following figure.

X

Configuration

Device Configuration l Connection Setup ]

e £ futo RECEIVER 1 Receiver RECEIVER 2
10.720 MHz *+ On Bandwidth

@ O I 1 kHz = I

ATTH 1 ATTH 2

20de - DUT delay 20dE -
0.00 =

Measurement
period

External 306 e
reference )

SDQI:I

Lewvel

0.00 dBm

ouTPUT

QK | Cancel | Help

Note: The source signal is externally connected to the channel 1 input (CH1)
behind the 50 Q source resistor (channel 1 voltage v, = ¥, as defined in
3.1 "Basics" on page 22).

2. Connect the reference point of the DUT to the INPUT CH 1 connector using
a cable.

25
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3.3 Example: Gain/Phase Measurement

Expected example duration: 20 minutes.

In this example you will learn step by step how to use the Gain/Phase mode of
the Bode 100.

How to:

» Measure the gain and phase of a DUT with a sinusoidal signal at a frequency
+ Set the bandwidth, attenuators and amplitudes of the Bode 700

* Optimize the diagram

+ Compensate the connection cables in the Gain/Phase mode

Question: What is the magnitude in dB of the delivered IF filter at 10.7 MHz?
These types of 10.7 MHz filters are used in FM radios.

26
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To find out the answer, proceed as follows:
1. Connect the Bode 100 and start the Bode Analyzer Suite.
2. Click the Gain/Phase toolbar button .

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode E”E|E|
File  Measurement  Configuration  Calibration  Trace  Tools  Help
DEHEER Ao @ ¢ (EEEEE
& User Calibration.., 7% Frobe Calibration. .. Kia -
Source Result
Source Frequency | 1110MHz Mag [dB] B -37.263 dB
|Phase () B 30522°
Configuration
Level 0.00 dBm
&
Altenwator CH1 |20 dB -
4
Attenuator CH2 | 20 4B hd 9
Receiver Bandwidth |1 kHz hd 2
1
o v
1
-2
-3
-4
-5
4 2 o 2 4
[ |

Hint: If you see the Bode 100 serial number in the status bar on the lower
right side of the window then the Bode Analyzer Suite communicates with the
Bode 100. Otherwise check whether your Bode 7100 is connected and
powered properly, and then click the Search and Reconnect Device toolbar
button &3,

3. Click the Device Configuration toolbar button %, to configure the
Gain/Phase mode.

27
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4. In the Configuration window, set:

Configuration

Device Configuration l Connection Setup ]

SOURCE © Auto

Receiver

X

1110 Mz e o RECEIVER 1 Banduwidth RECEIVER 2
@ Ok I 10Hz - I
ATTH 1 ATTH 2
20dB - DUT delay 20dE =
0.00s
E i Measurement
. | period
Internal 265,24 ms
reference )
500 D
L
Lewvel
0.00 dBm
ouTPUT
QK | Cancel | Help

Hint: Setting the receiver bandwidth to 10 Hz makes the readout more stable

CH2: 50 © ON (click the switch as shown)

SOURCE: 10.7 MHz

SOURCE: On or Auto

Receiver bandwidth: 10 Hz

ATTN 1 (channel 1 input attenuator): 20 dB
ATTN 2 (channel 2 input attenuator): 20 dB

i (before ATTN1) to the internal source as reference

The switch |

Level: 0 dBm“

-

but also makes the measurement slower.

28
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5. Click the Connection Setup tab.

Configuration

Device Configuration  Connection Setup l

| IUTPL - NPUT
5 = L]
O eode 100 . gnachon

Thru Cable
or Probe

Two Port DUT

Channel 2 External Probe

QK | Cancel | Help

The connection diagram shows how to connect the DUT to the Bode 100.

Channel 2 External Probe:

Hint: Set the voltage ratio in the box [+ — | if you use a probe
instead of cable connection (see 10.2 "Advanced Sweep Options" on
page 140).

6. Connect the IF filter to the Bode 100 as shown.
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7. Click __% | to close the Configuration window and to get back to the
Gain/Phase mode window.

8. For a better view of the Gain/Phase vector in the complex plane, right-click
in the diagram, and then click Optimize.

5

4

3

2 Zoom Mode

, Optimize
Reset Axes

L Grid Polar

-1 Copy

s Copy with Settings

3

4

-5

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File  Measurement  Configuration  Calibration  Trace  Tools  Help
DEE &R =y b.a @ ¢ EEERER
& User Calibration.., 7% Frobe Calibration. .. Kia -
Source Result
Source Frequency | 10,700 MHz Mag [dB] B -31.254 dB
|Phase () B 73563 °
Configuration
Level 0.00 dBm
Alteruatar CH1 ’m 0.025
Attenuator CH2 | 20 4B hd 0.020
Receiver Bandwidth |10Hz hd oos
0.010
0.005
0.000
-0.005
-0.010
-0.018
-0.020
-0.025
-0.02 0.00 0.02
Source: On [ [
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Gain/Phase Mode

Result: The IF filter has a magnitude of —31.26 dB at 10.7 MHz. Your result may
differ because each IF filter is slightly different.

The phase readout of 73.6° is not the value you want to measure because it is
the sum of the phase shift of the cables and of the IF filter. To get the value of
the IF filter only, use the Gain/Phase calibration to compensate the phase shift
of the cables.

Continue the example and calibrate the Bode 100 to get the phase shift of the IF
filter:

1. Replace the IF filter with the BNC straight adapter (f—f).

2. Click the User Calibration toolbar button : & User caltration... to open the
calibration window.

3. In the calibration window, click Start in the Gain/Phase area.

User Calibration - Gain/Phase

Gain/Phase
Feplace DUT by thru cable. Afterwards press Start to perfom

Calibration.
Thru Start Perfarmed

Impedance

e | I
e | I
e |

Advanced

INNERRRENRENENENNEEEEN
QK | Cancel | Help |
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The calibration takes only a few seconds. The Gain/Phase mode is now
calibrated for the current specific measurement setup.

4. Click ok |,
5. Reconnect the IF filter.

Hint: If you change settings you must repeat the User Calibration. If you use

the Probe Calibration : = Freecaibration... jnstead you can change settings without
repeating the calibration. For more information, see 8 "Calibrating the Bode 100"
on page 89.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File ~ Measurement  Configuration  Calibration  Trace  Tools  Help
DEH&ER @ [P o @ e [HEEEEE
B User Calibration... g}_\ Probe Calibration. .. Xz =
Source Rezult
Source Frequency | 10,700 MHz [Mag [dB) = -31.254 4B
o [Phase ['] = ] 73154°
Configuration
Level 0.00 dBrn
Alteruator CH1 |20 4B hd 0.025
Aftenuator CH2 |20 48 - 0.020
Receiver Bandwidth |10Hz hd o018
0.010
0.005
0.000
-0.005
-0.010
-0.015
-0.020
-0.028
-0.02 0.00 0.02
[ |

Result: The transfer function of the IF filter has a magnitude of —31.29 dB and
a phase shift of 73.2° at 10.7 MHz.

Again, your results may differ because every IF filter and measurement setup is
slightly different.

Hint: You can toggle between the measurement results with calibration and
without calibration by clicking the GAIN ON toolbar button [eamon].
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Congratulation! You learned how to use the Gain/Phase mode.
How to:

» Measure the gain and phase shift of a DUT using a sinusoidal signal at a
certain frequency

» Set the bandwidth, attenuators and amplitude of the Bode 700
» Optimize the diagram

» Compensate the connection cables in the Gain/Phase mode

As OMIfuzius said: Only ~ Go back to the overview chart at 3 "Gain/Phase Mode" on page 19 and try
applied knowledge different settings to check out their effect on the measurement.

changes the world. We

are responsible to

change it to the better.
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Impedance/Reflection Mode

4

Figure 4-1:
Impedance/Reflection
mode window

Impedance/Reflection Mode

For the description of the menu bar,
toolbar, and calibration and trace
functions toolbar, see 9 "Common
Functions" on page 117.

Results

Graphical display of measurement results —
Use the shortcut menu to optimize the display.
See Figure 3-4: "Graphical display of
measurement results" on page 21.

Select the result format and get result values.
See Figure 4-2: "Impedance/Reflection mode results" on page 36.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

ile  Measurement  Configuration — Calibration  Trace  Tools  Help

NEEHER as .o @ e BEEERE

Xl

Reference Resistance 50.00 € ==y

& User Calibration, ., % Probe Calibration. . T
ﬁe \ pedance Admitance Reflection \
Source Frequency 1.000 MHz [Fieal B 51.8130 [Fieal B 17.891 mS [Magide) ] | -16.926 B
[Imag B 145400 [Imag B £.021 mS [Phase ) =] | FATET
Canfiguation
— Level | 0.00dBm
® s o
Attenuator CH1 |20 dB - a0
e 2005 s
Atteruator CH2 |20 4B - c . " & o -
Rieceiver Bandwidih |1 kHz - - = s T
a0
-& -ams =
Measuement
omt om oo

rial equivalent circuit
R:=518130)
— ANt

Ls=2314pH
Q =280.620m

Parallel equivalent circuit

Rp=558330Q

e

Lp=31.700 uH
0=280620m

Equivalent circuits
View the equivalent circuits

Reference resistance
Set the reference resistance (see
4.1.1 "General Formulas" on page 36).

Configuration and measurement setup
See Figure 3-2: "Configuration and
measurement setup” on page 20.

(see 4.1.2 "Equivalent
Circuits" on page 37).

Source, overload, and connection
indicators

See Figure 3-5: "Source, overload, and
connection indicators" on page 21.
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Figure 4-2:

Impedance/Reflection

mode results

4.1
411

Select the output format
of the impedance
measurement results.

Select the output format
of the admittance
measurement results.

Select the output format
of the reflection
measurement results.

Impedance Admittance Fieflection
|Real ~H| 51.8130) |Real ~H| 17.891 mS |Mag(dB] ~H| -16.925 dB
lmag = H| 1454000 |Imag ~H| 5021 mS |Phase ] = H| 74767 -
Display of the respective measurement
results in the selected format.
Basics

General Formulas

The general formulas related to the Impedance/Reflection measurements are

summarized below:

4
7 ==
-1

1 1
Y===-=
N A/
L Z-Ry Gy-Y
T Z+R, GytY

+
vswr = LI
1= [r]
1
R = —
0
GO

where
14 ...voltage at the reference plane
I ..current at the reference plane
VA ...impedance
Y ...admittance
r ...reflection coefficient
VSWR ..voltage standing wave ratio
R, ...reference resistance
G, ...reference conductance

(Eq. 4-1)

(Eq. 4-2)

(Eq. 4-3)

(Eq. 4-4)

(Eq. 4-5)
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Note: The reference resistance R, can be set in the Measurement area of the
Impedance/Reflection mode window.

4.1.2 Equivalent Circuits

The basic formulas for the serial equivalent circuit are:

Z = Real(Z) +jlmag(Z) = R +/X, (Eq. 4-6)
R, = Real(2) (Eq. 4-7)
If Imag(Z)<0:

_ 1 -
C, = olimae D) (Eq. 4-8)

If Imag(Z2)>0:

L, = . (Eq. 4-9)
where

R,  ...series resistance

X, ...series reactance

C,  ...series capacitance

L, ...series inductance

The basic formulas for the parallel equivalent circuit are:

Y = Real(Y) +;Imag(Y) = L-&-](_—l) (Eq. 4-10)
B B B RP XP -

-1 -

R, = Real(7) (Eq. 4-11)
If Imag(Y)<0:

_ 1 -
L,= oTimag(T) (Eq. 4-12)
If Imag(Y)>0:

_ [Imag(Y)|
C, = — (Eq. 4-13)
where
R, ...parallel resistance
X, ...parallel reactance
L, ...parallel inductance
C,  ...parallel capacitance
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Depending on the regional settings of your computer the elements of the serial
and parallel equivalent circuits are displayed according to the IEC (International
Electronic Commission) or ANS/ (American National Standards Institute)
standards as shown below.

Figure 4-3:

Resistor and inductor . . .
symbols according to Farallel equiralent circuit

ANSI Fip=8.093 0

D

Lp=153.437 nH
0 =833

Figure 4-4:

Resistor and inductor = lll walent ci i
symbols according to araliel equivalent circLl

IEC Rp=83780

i

Lp=152.728 nH
0 =9355

Note: Capacitors have the same symbol —]}— in both standards.
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4.1.3 Quality Factor

An ideal inductor will be lossless irrespective of the amount of current flowing
through the winding. An ideal capacitor will be lossless irrespective of the
voltage applied to it. However, real inductors have a winding resistance due to
the metal wire forming the coils and real capacitors have a resistance due to the
used insulation material. These resistances cause a loss of inductive or
capacitive quality. For serial equivalent circuits, the quality factor Q is defined as
the ratio of the reactance to the resistance at a given frequency. For parallel
equivalent circuits, the quality factor Q is defined as the ratio of the resistance
to the reactance at a given frequency.The ¢ factor is a measure of the inductor’s
and capacitor’s efficiency. The higher the Q factor of a capacitor or inductor, the
closer the capacitor/inductor approaches the behavior of an ideal, lossless
component.

The Q factor calculated using the serial equivalent circuit is given by

_ [mag(z)] _ X

- Rl " R (Eq. 4-14)
and using the parallel equivalent circuit is given by
1
_ mag(n) _ [ Ry ]
0 Real (V) TR (Eq. 4-15)
R

4.2 Example: Impedance/Reflection Measurement

Expected example duration: 20 minutes.

In this example you will learn step by step how to use the
Impedance/Reflection mode of the Bode 100.

How to:

» Measure the reflection coefficient at a frequency

+ Set the bandwidth and amplitudes used for the measurement

» Connect the DUT for the impedance and reflection measurement
* Optimize the diagrams

+  Work with the serial and parallel equivalent circuits

Question: What is the reflection coefficient in dB of the delivered IF filter’s input
at 10.7 MHz?
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To find out the answer, proceed as follows:

1.

Connect the Bode 100 and start the Bode Analyzer Suite.

Hint: If you see the serial number of your Bode 100 on the lower right side of
the status bar then your Bode 100 is working properly.

Impedance/Reflection mode.

. Click the Impedance/Reflection toolbar button [ to switch to the

If necessary, adjust your window size. Move the mouse to the lower right

corner of the window

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

. By dragging the corner you can adjust the window.

File ~ Measurement  Configuration  Calibration  Trace  Tools  Help

NEEHER as .o @ e BEEERE

& User Calibration, ., % Probe Calibration. . T X
Saurce Impedance Admittance Fieflection
Source Frequency 1.000 MHz [Real Bl 26138 02 [Real Bl 2557 45 [Magicg) | | -2.256 maB
[Imag Bl 3176 k0 [Imag Bl 314.854 45 [Phasery =] | 1.604"
Canfiguation
Level 0.00 dBm o o 10
Attenuator CH1 |20 dB - 2 B o=
1 1o
Attenuator CH2 |20 dB -
c o w o L]
Fieceiver Bandwidth |10 Hz - -1 100
-2000 -200u o
Measuement -2 2o
o e 2 S [ 200 1
Fieference Resistance 50.00 22 a s
Serial equivalent circuit Paralel equivalent circuit
Fs=26.198 Q) Aip = 385.026 kO
——— T
Cs=50.114 pF Cp=50.111pF
0=121.227 0=121.227
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4. Click the Device Configuration toolbar button %, to configure the
Impedance/Reflection mode.

X

Configuration

Device Configuration l Connection Setup ]

it £ futo RECEIVER 1 Receiver RECEIVER 2
10.700 MHz *+ On Bandwidth

@ o I 10Hz = I

ATTH 1 ATTH 2

20de - DUT delay 20dE -
0.00 =

Measurement

period

Internal 265.24 ms
reference

SDQI:I

Lewvel

0.00 dBm

ouTPUT

QK Cancel Help
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5. Set:
+ SOURCE: 10.7 MHz
+ SOURCE: On or Auto
* Receiver bandwidth: 10 Hz
* Level: 0dBm
6. Click the Connection Setup tab.

Configuration rX

Device Configuration  Connection Setup l

n. Termination

Two Port DUT

One Port DUT

S 2 R

QK | Cancel | Help

The connection diagram shows how to connect the DUT to the Bode 100.

Hint: In the Impedance/Reflection mode, the channel 1 and channel 2
inputs are not used. Consequently, the External Probe boxes are
unavailable.
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7. Connect the output of the Bode 700 to the input of the IF filter and the BNC
50 Q load to the output of the IF filter as shown.

IF Filter

OMICRON

| =
!M'l'
Q

uartz Filter
N

8. Click __ % | to close the Configuration window.

9. For a better view of the impedance, admittance and reflection vectors in the
complex plane, right-click in the respective diagrams, and then click Optimize.

100

Zoom Mode
50 Optimize
Reset Axes
a o Grid Polar

Copy
Copy with Settings

-50

-100
-100 -50 0 50 100
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10.View the results.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File ~ Measurement  Configuration  Calibration  Trace  Tools  Help

Bl =R asp @ e EEEER

& User Calibration, ., % Probe Calibration. . T

{
Xl

Source Impedance Admittance Feflection

Source Frequency 10.700 MHz [Real Bl 5157002 [Real Bl 19390 mS [Magicg) | | -36.011 dB

[Imag ~| | amsmn [Imag | | 123 [Phasery =] | 12179°
Canfiguation

gm0

Attenuator CH1 |20 dBt -

gm0

Level 0.00 dBrn
‘ 05

aas
aas ‘

Attenuator CHZ |20 dBt -

Fieceiver Bandwidth |10 Hz - 2005

2010

a0t
Measurement

Reference Resistance 50.00

oa

Serial equivalent circuit Farallel equivalent circuit

Rs=51.5700 Rp=51.5730
B Lo
Ls=5124rH Lp=114.827 yH
Q=663 m 0 =BEETm

Result: The measured values of the IF filter at 10.7 MHz are:
» Reflection coefficient: —36.0 dB
* Impedance: nearly 50 Q

Again, your results may differ because every IF filter and measurement setup is
slightly different.

Hint: Toincrease the size of the diagrams, make the window larger or hide the left
pane by clicking the split bar. To restore the left pane, click the split bar again.

Hint: If you want to display the reflection in VSWR format select the VSWR
output format under Reflection as shown below.

Reflection

[vswR ]| | 1,085

Usually, the reference resistance of 50 Q is used to calculate the reflection
coefficient and the VSWR. The Reference Resistance box allows you to enter
other reference resistance values if required.

The parallel and serial equivalent circuits give us an indication of the electrical
components that would be required to rebuild the electrical characteristics of

your DUT at the measurement frequency. In our example you would require a
5.124 nH inductor and a 51.57 Q resistor to build the series equivalent circuit.
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Try it out, get yourself the required components and repeat the measurement. If
the results do not match 100% keep in mind that you are using real components
with a @ factor on their own.

For information on how to calibrate the Bode 100 in the Impedance/Reflection
mode, see 8.4 "Calibration in the Impedance/Reflection Mode" on page 97.

\ / Congratulation! You learned how to use the Impedance/Reflection mode.
N

How to:

» Measure the reflection coefficient at a frequency

+ Set the bandwidth and amplitudes used for the measurement

» Connect the DUT for the impedance and reflection measurement
* Optimize the diagrams
* Understand serial and parallel equivalent circuits

After this example geta G0 back to the overview chart at 4 "Impedance/Reflection Mode" on page 35
glass of water to and try things out.

increase your reflection

mode and your attention

bandwidth. Then try

things out and right-click

and left-click to

everything that does not

move on the screen.
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5 Frequency Sweep Mode

Figure 5-1:
Frequency Sweep Sweep settings Cursor settings Trace settings
mode window Set frequency sweep. Set cursors and view Define measurement format
See Figure 5-2: "Sweep ——measurement results. and display options.
settings" on page 48. See Figure 5-3: "Cursor See Figure 5-4: "Trace
settings" on page 48. settings" on page 49.

Trace functions settings
Switch the Average, Min Hold, and Max Hold functions on
and off. See 5.1 "Example: Frequency Sweep Measurement"

OMICRON Lab - Bod 2 Analyzer Suite - NewBodehieasurement.Bode

File Measuwrement  Chbrfiguration  Calibration Tracel Tools  Help
SHEE s s @ ofHEEEEm
& User Calibration... % Prphe Calibration. . (iu Trace Functions. .. TRI AWG OFF TR2 AYG OFF X )
— Frequency Trace 1 Trace 2 & Trace 1 (TF)
Cumarl | 10706563 MH: 24,694 dB
Start Frequency 49.950 MHz = 0 N 45973 B Color _3
Stop Frequency 11.450 MHz | A| Measurement | Gain -
Displ Dat -
Center Frequency 10.700 MHz [ Vi | splay [Date
20 Fornat [Mag(dB] =
Span 1.500 MHz -30 mas [ 2000 4B
Swesp Mods |Linssr - -40 min [112.57 dB
o 50 -Scale: & Lin
Nurmber of Pairts - -
® Lag TR1
g  LogITR1I
¥ T
= Data->Memory
-80
Gy - Em
Level j 0.00 dBm -100 WV Trace 2(TR2)
Attenuster CH1 |20 dB - =0
10.0M 10.5M 11.0M coor [ |
Attenustor CHZ |20 dBt - fiHz Measwement |Reflection  ~
TR1: Mag(Gain) .
Riscsiver Bandwidt |1 kiz - Display [Data ]
Fomat [Magld) =
Measurement = Ymax |-24.70 dB
e [zmE
Reference Resistance 50000 i | kil
-30 Y-Seale: * Lin
o " LogTR2
= " LogITR2|
o 34
= Data->Memary
-38
-40 Diagram Setup
- it
10.0M 10.5M 11.0M Q Always Twa Diagrams
fiHz
TR DGR ( Export Traces Data. | )
[ TR avG OFF [ TRe: AVGOFf o I 0|
Diagram setup Export traces data
See Figure 5-6: "Diagram —8 Export traces as CSV file.
setup” on page 51. See 9.4.2 "Exporting Measurement

Data" on page 122.

Note: Only window areas specific for the Frequency Sweep mode are
explained here. For window areas common to other measurement modes, see
Figure 3-1: "Gain/Phase mode window" on page 19 and Figure

4-1: "Impedance/Reflection mode window" on page 35.
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E In the Frequency Sweep mode you can perform a sequence of Gain/Phase
and/or Impedance/Reflection measurements and examine the results in
different types of diagrams.

Figure 5-2:
Sweep settings
Sweep
. Set the frequency sweep
Start Frequency: | 3.350 MHz T | start frequency.
} Set the frequency sweep
StEII:I FTE-'EILJE-'T'IC_'I-'. | 11.450 MHz | stop frequency.
. Setthe frequency sweep
Center Frequency: | 10700 MHz ——ter frequency.
. Set the frequency sweep
Span: | 1.500 MHz T span.
Click Linear or
. . | Logarithmic to select
SWE"EF' bode: | Linear bl the respective scale of

measurement points.
b | Set the number of
NLJIT||:IE.'T DI: PDmtE' |-I Em hl measurement points.

Copy from Zoom
—___See "Copy from Zoom"
on page 131.

Hint: The start frequency, stop frequency, center frequency and span are
mutually dependent. After one of them has been changed, the others settings
are recalculated by the Bode Analyzer Suite.

Figure 5-3:
Cursor settings Select the check box Trace 1 measurementresult Trace 2 measurement result
to activate cursor 1. marked by cursor 1. marked by cursor 1.
Frequency marked Trace 1 measurementresult Trace 2 measurementresult
by cursor 1 marked by cursor 2. marked by cursor 2.
Frequency Trace 1 Trace 2

10.700 MHz 30,638 dB 33403 dB
11300 MHz 90,698 dB 25,518 dB

delta C2-C1 B00.000 kHz -60.060 dB 7.885 dB

Frequency marked Difference of cursor Difference of trace 1 Difference of trace 2
by cursor 2 frequencies measurement results ~ measurement results

Select the check box
to activate cursor 2.
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Figure 5-4:

Trace settings Select the check box to activate trace 1.

v Trace 1 [TR1)

Colar -3—
Gan |
Daa -]
[MaoldB) |

-30.07 48

teazurement
Dizplay

Format

Set the color of trace 1.

JCIick Gain, Reflection, Impedance

or Admittance to select the

—l_respective trace 1 measurement.
—I_Display

See "Data and Memory" on

page 134.
Select the output format of trace 1

mas

“min |-102.93 dB

measurement results.

YScale: ¢ Lin
" Log TR1
" Lag[TR1|

Set the maximum value on
the trace 1 Y-axis.

Set the minimum value on
the trace 1 Y-axis.

Data —> Memory

See "Data and Memory" on

D ata-»Memaory

page 134.

Main | Adwanced l

[ Trace 2 (TRZ2)

I -
[Fieflection_~
Dizplay m
Farmat m
Ymax |-24.84 dB
it lw

Y-Scale: ™ Lin
" LogTRZ
" Log|TRZ|

Colar

teasurement

Diata-»Memory

For the Advanced tab, see Figure
5-5: "Advanced trace settings" on
page 50.

bain | Advanced

Hint: The Trace 2 settings are as for Trace 1.
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Figure 5-5:
Advanced trace settings

[ ET

Main  Advanced

Hint: The Trace 2 settings are as for Trace 1.

Select the check box to activate trace 1.

Trace 1 [TR1]

runrapped Phaze

Urwwapped Phase v

Beqin 100.000 kHz  |»

End 40,000 MHz |+

Advanced |

v Trace 2 [TR2)

Jrwrapped Phaze
Urwrapped Phaze v

Begin 100,000 kHz v
End 40.000 tHz |+

Select the check box to switch the
unwrapped phase on.

See 10.3 "Unwrapped Phase" on
page 144.

Set the frequency from which the
unwrapped phase measurement
begins.

See 10.3 "Unwrapped Phase" on
page 144.

Set the frequency from which the
phase is shown wrapped again.
See 10.3 "Unwrapped Phase" on
page 144.

Click the Advanced tab.
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Figure 5-6:
Diagram setup Click Auto to display both traces
in one diagram, if this is possible.

Diiagram Setup
— Auta

— Always Two Diagrams

Click Always Two Diagrams
to display the traces in two
separate diagrams.

Note: Diagram Setup is only available if both traces are activated.
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5.1

Example: Frequency Sweep Measurement

Expected example duration: 30 minutes.

In this example you will learn step by step how to use the Frequency Sweep
mode of the Bode 100.

How to:

Visualize measurement data in a graph

Set configuration parameters like the input resistor and bandwidth
Set sweep parameters like start and stop frequencies

Use cursors to read single measurement points

Calibrate and compensate the cables

Let’'s examine the12 MHz quartz filter on the delivered printed circuit board
(PCB).

Questions:

How does the gain of the quartz filter look like if displayed as a function of
frequency?

How does the reflection coefficient of the quartz filter look in the Smith chart?

What are the filter’s series resonance and the parallel resonance
frequencies?

What is the attenuation of the quartz filter at its series resonance?
What is the group delay T of the quartz filter at its series resonance?

What is the series resistance R, of the quartz filter?

To find out the answers, proceed as follows:

1.

Connect the Bode 100 to the computer and start the Bode Analyzer Suite.

2. Click the Frequency Sweep toolbar button to switch to the

Frequency Sweep mode.

3. Click the Device Configuration toolbar button %, to configure the

Frequency Sweep mode.
We want to measure the quartz filter with 50 Q load.
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4. Set:
+ SOURCE: On or Auto
» CH2: 50 Q ON (click the switch as shown)

+ Theswitch | / | (before ATTN1) to the internal source as reference
Configuration g|
Device Configuration l Connection Setup ]
Measurement: % Gain/Phase " Impedance/Reflection
SOURCE Fimae

g g“‘“ RECEIVER 1 B:ﬁdexﬂth RECEIVER 2

* On

O I A Hz - I

@ ATTH 1 ATTH 2
1048 ~ DUT delay 10d8 =
0.00s
i H Measurement i i
| f period i i
Internal 85 69 e
reference )
500 D
]
Lewvel
ouTPUT
QK | Cancel | Help

Hint: In the Frequency Sweep mode, the Bode 100 can measure the
gain/phase as well as the impedance/reflection of the DUT versus frequency.
The Gain/Phase and Impedance/Reflection buttons in the Configuration
window are just used to show the respective device configurations. The
buttons have no impact on the measurements performed by the Bode 100 —
you select the measurement in the Measurement lists in the Trace 1 and
Trace 2 areas (see Figure 5-4: "Trace settings" on page 49). To see the
device configuration the Bode 700 uses for the Impedance/Reflection
measurement just click the Impedance/Reflection button.
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Hint: With a narrow receiver bandwidth like 30 Hz, the measurement is very
selective. Only little noise will affect the measurement and, consequently, the
measurements will be more stable but the sweep will be slow. The receiver
bandwidth of 3 kHz will perform the fastest sweep.

5. Click the Connection Setup tab.

Configuration

Device Configuration  Connection Setup l

OUTPLU
1 Y Bode 100 . C——LAB

Thru Cable
or Probe

Twao Port DUT

One Port DUT

Channel 2 External Probe
— T -
QK | Cancel | Help

The connection diagram shows how to connect the DUT to the Bode 100.

Channel 2 External Probe:

Hint: Use the v ] box to set the voltage ratio when you use a
probe instead of cable connection (see 10.9 "Using Probes" on page 171).
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6. Connect the quartz filter to the Bode 100 as shown.

7. Click __% | to close the Configuration window and to get back to the
Frequency Sweep mode window.

8. Set the sweep frequencies:
» Start frequency: 11.98 MHz
» Stop frequency: 12.04 MHz
* Number of points: 401

The other settings will be automatically calculated and the Sweep area of the
Frequency Sweep mode window should now look like below.

Sweep

Start Frequency: 'm
Stop Frequency: 'm
Center Frequency: 'm
Span: E0.000 kHz

Sweep Mode: m
Murnber of Paints: ’m
—CopyfomZoon |

Hint: A setting which results in an out-of-range frequency for any other
parameter will be corrected to ensure that all sweep frequencies (start, stop,
center) are within the range of 10 Hz...40 MHz or 1 Hz...40 MHz if you
selected the extended measurement range (see 9.2 "Setting the
Measurement Range" on page 120).
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9. Set the reference resistance.

Default: 50 Q

Measurement

Reference Resistance: 50.00 &

Hint: The reference resistance is used to calculate the reflection coefficient
and the VSWR.

10.Activate both traces and set the parameters as shown below.

¥ Trace1[TR1)

Caolar _Z‘
Measurement ’m
Dizplay ’m
Format ’W‘
rmax ’W

“min |-100.00 dB

Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

Main | Advanced

¥ Trace 2[TR2)

Caolar _Z‘
Measurement ’W‘
Dizplay ’m
Faormat ’m

[rata-»kemary

Main | Advanced
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11.1f you have a larger screen you can adjust your window size. Move the mouse
to the lower right corner of the window @ and drag the corner.

Hint: In addition to resizing the window, you can click the split bar to hide the
left and right panes to increase the size of the diagrams.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help

NEHED s M [@ e HEEE

& User Calibration. .. % Probe Callbration... %1z Trace Functions. . TRI AVG OFF TRZ AYG OFF XJ
Frequency Trace 1 Trace 2 % Tiacel (TR1)
color NN ~ |
delta C2.L1 Measurement | Gain -

Display |Data -
[ Fomat |MagldB) =
2 Ymay [20.00 dB
Ymin |-100.00 dB
Y-5eale: @ Lin
© Log TR
" LogITRII

Data->Memory
< / Main_[Advanced |

-80 v ¥ Tiace 2(TR2)

11.98M 11.99M 12.00M 12.01M 12.02M 12.03M 12.04M
f1Hz Measurement |Reflection =

TR1: Mag(Gain) Display | Data -
Format | Smith A

TR1/dB
&

Data->Memory
bain | Advanced

Diagram Setup
" Auta

& Always Two Disarams

TR2: Reflection Export Traces Data.. \

[Tri: AvaorF [ TRe: AVGORF Ton 1 o0 [ e

In the upper graph you see the gain of the quartz filter. You can use the
cursors to measure the series and parallel resonance frequencies.

12.Select the Cursor 1 and Cursor 2 check boxes to activate the cursors.
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13.To find the series resonance frequency of the quartz filter, right-click the
curve in the upper diagram, point to Cursor 1, and then click Jump to Max.

N Lab - Bode Analyzer Suits

File  Measurement Configuration  Calbration  Trace  Tools  Help
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& User Calibration. . % Probe Callbration... Xy Trace Functions... TRI AYG OFF TRZ AYG OFF %)
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Copy WV Trace 2 (TR2)
Copy vith Setti
o apy with Settings »
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Diagram Setup
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I L I
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14.To find the parallel resonance frequency of the quartz filter, right-click the
curve in the upper diagram, point to Cursor 2, and then click Jump to Min.
In the marked area of the Frequency Sweep mode window, the series and
parallel resonance frequencies and the corresponding measurement data
are now displayed.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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&
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Results: Cursor 1 marks the series resonance frequency of 11.997 MHz and
an attenuation at the series resonance frequency of 0.722 dB.

Cursor 2 marks the parallel resonance frequency of 12.020 MHz and an
attenuation at the parallel resonance frequency of 81.848 dB.

59



Bode 100 User Manual

15.To measure the group delay of the quartz filter at its series resonance

frequency, select Tg in the Format list.
The following figure shows the group delay measured by Trace 1 at the

series resonance frequency marked by cursor 1.
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Result: The group delay T at the series resonance frequency of the quartz
filter is 263.044 us. Due to the high attenuation at the parallel resonance
frequency it is not possible to measure the group delay at the quartz filter's

parallel resonance.

Your result might be slightly different because even quartz filters show
variations in their electrical characteristics.

16.For the measurement of the series resistance of the quartz filter we will use
the Smith chart. The Smith chart displays the reflection coefficient (see (Eq.
4-3) on page 36) in the complex plane. The horizontal axis represents the
real component and the vertical axis the imaginary component of the DUT's
reflection coefficient. The central point of the Smith chart corresponds to the
case when the DUT’s impedance equals the reference resistance and,
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consequently, the reflection coefficient is zero.

Additionally, the Smith chart contains circles with constant resistance (R)
and constant reactance (). This diagram format allows an easy "translation"
of any point of the reflection coefficient curve into the corresponding DUT’s
impedance. The cursor values displayed in the Smith chart format are the
real and imaginary components of the corresponding DUT’s impedance. For
more information on the Smith chart, refer to the relevant technical literature.

17.In the lower graph you see the Smith chart showing the reflection coefficient
of the quartz filter. To display only this chart, clear the Trace 1 check box to
deactivate trace 1.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help

DEEER =2y [@e BEEEE
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hain

10 250 ¥ Tiace 2(TR2)

500

Measurement | Reflection =
1,000 e
2500 Display [Data =
500 Fomat [Smith |
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50
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-200 Datar>Memary
bain | Advanced

Diagram Setup

-20

-100 2

-30 &
-75

TR2: Reflection Export Traces Data...

[TRL AVG OFF [ TRe: AV6 OFf

Since the output of the DUT (quartz filter) is connected to the channel 2 input,
the measured impedance is the quartz impedance plus the 50 Q input
impedance of the Bode 100.

For an idle quartz, the trace should be nearly symmetrical against the real

axis. The reason why it is not is as follows: We have used a cable to connect
the quartz filter to the Bode 700 and therefore we measure a phase shift of
the reflected voltage (twice the shift of the cable itself). We can remove this
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unwanted phase shift by using the Impedance calibration. By calibrating the
Bode 100 we move the Impedance/Reflection reference plane to the end of
the cable connected to the input of the DUT.

5.2 Impedance Calibration

Now we perform the Impedance calibration. This type of calibration is also

described in 8.4 "Calibration in the Impedance/Reflection Mode" on page 97.

1. Click the Probe Calibration toolbar button i &t Frebs Calirration... to open the
calibration window.

Probe Calibration

Gain/Phase
Feplace DUT by thru cable. Afterwards press Start to perfom
Calibration.

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Advanced

Ok | Cancel | Help |

2. Connect the cable you want to use for the measurement to the OUTPUT
connector of the Bode 100. Plug the BNC straight adapter on the other end

of the cable.
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3. Click the Start button next to Open in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Open Start | Performed

With the measurement settings the calibration may take a few seconds.
4. Plug the BNC short circuit on the straight adapter connected to the cable.

5. Click the Start button next to Short in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Short Start | Perfarmed

6. Replace the BNC short circuit with the BNC 50 Q load.
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. For very accurate measurements or if you use a load resistor different from

50 Q, click the + symbol next to Advanced, and then enter the exact
resistance of the load resistor.

[=] Advanced

Load Resistor |50.00 €2

Shart Delay Timne |5U-DD ps

Hint: For more information on the advanced calibration settings, see
8.4 "Calibration in the Impedance/Reflection Mode" on page 97.

. Click the Start button next to Load in the Impedance area of the calibration

window. After the calibration has been finished, the field on the right displays
Performed on green background.

Load Start Perfarmed

. After the calibration has been finished, the calibration window looks like

shown below.

Probe Calibration

Gain/Phase

e | R

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed
Load Start Perfarmed
Advanced
L]
Ok | Cancel | Help |

Hint: The warning symbol indicates that the load resistor and/or the short
delay time value differ from the factory settings.

10.Click __ 9% |, You have done the Impedance calibration in the

Frequency Sweep mode.
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11.Reconnect the quartz filter to the Bode 100 as shown below.

12.View the calibrated Smith chart.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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200
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(571580 Onm 2500 Display |Data =
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10 20 30 4011%%5 3“7725 100 180 200250 5001,02,5] Farmat | Smith -
B
1,000
-500
0 /
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20 Diagram Setup
-100 o
-30 “
-6
-40 50
TR Expictt Tracss Dsta
[ TR G OFF [ TRE: 4G OFF Mo T Woe 7

13.Calculation of the series resistance Rr_ at the series resonance frequency:
To calculate the series resistance of the quartz filter you need to subtract
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Frequency sweepers
have an easier time to
get the picture.

50 Q from the real part measured with cursor 1. The reason for this is that the
reflection measurement circuit "sees" the quartz filter in series with the 50 Q
termination of the channel 2 input.

The Trace 2 columns of the cursor table display the real and imaginary parts
of the measurement results at the frequencies marked by the cursors.

Result: R, =57.158 O —-50 0 =7.158 Q

Your result may slightly differ because every quartz filter and measurement
setup is different.

Congratulation! You learned how to use the Frequency Sweep mode.

How to:

Visualize measurement data in a graph

Set configuration parameters like the input resistor and bandwidth
Set sweep parameters like start and stop frequencies

Use cursors to read single measurement points

Calibrate and compensate for the cable

Go back to the Frequency Sweep mode window in 5 "Frequency Sweep Mode"
on page 47 and try things out.
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6 Frequency Sweep (External Coupler)
Mode

Figure 6-1:
FrequenCy Sweep OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
(External Coupler) Fle Measurement Corfiguration  Calbration  Trace  Tools  Help
mode window NEH @3 A [FH s @ @ BEEEE
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biteruator CH2 [20 o8 - iti M Ref
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Fomat [VSWR  ~
Measurement 24 Ymax |250
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YScale: & Lin
20 " LogTR2
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»E—E‘ 18
18 Data->Memory
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@ Diagram Setup
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<

Note: The window areas and screen elements in the Frequency Sweep
(External Coupler) mode are the same as in the Frequency Sweep mode. For
their description, see Figure 5-1: "Frequency Sweep mode window" on page 47.

[14] In the Frequency Sweep (External Coupler) mode you can perform a
sequence of Impedance/Reflection measurements by using an external
directional coupler only or in combination with an external amplifier.

For some impedance measurement applications, it is beneficial to use external
couplers for an optimum adaptation of the Bode 100 to the test object (see
Figure 6-2: "Connecting external coupler" below). Further on, impedance
measurements on some test objects such as medium wave antenna systems
require higher signal levels than provided by the Bode 100. By using an external
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Figure 6-2:
Connecting external
coupler

Figure 6-3:
Connecting external
coupler and amplifier

coupler it is possible to utilize an external amplifier to boost the Bode 100 source
signal to the required output level (see Figure 6-3: "Connecting external coupler
and amplifier" below).

— DUT

> — DUT

N

Hint: By using an external amplifier and an external coupler you can protect the
Bode 100 inputs and the source output from reverse power emitted by the DUT
(e.g. radio waves received by a broadcast antenna).
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6.1 Example: Frequency Sweep
(External Coupler) Measurement

Expected example duration: 30 minutes.

In this example you will learn step by step how to use the Frequency Sweep
(External Coupler) mode of the Bode 100.

How to:

» Connect an external coupler

» Set configuration parameters like the input resistor and bandwidth
» Calibrate and compensate the connection system

» Display reflection in VSWR format

» Display impedance in polar format

* Remove the effect of noise

Let’'s examine the delivered IF filter when connected to the Bode 700 by means
of a 50 Q directional coupler.

Questions:
+  What is the VSWR of the IF filter within its passband?
» How does the impedance of the IF filter look like in polar format?

+  What is the exact impedance and VSWR of the filter at its center frequency
of 10.7 MHz?

To find out the answers, proceed as follows:
1. Connect the Bode 7100 to the computer and start the Bode Analyzer Suite.

2. Click the Frequency Sweep (External Coupler) toolbar button () to switch
to the Frequency Sweep (External Coupler) mode.

3. Click the Device Configuration toolbar button %, to configure the
Frequency Sweep (External Coupler) mode.
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4. Set:

SOURCE: On or Auto

CH1: 50 Q ON
CH2: 50 QO ON

Configuration

Device Configuration l Connection Setup ]

SOURCE © Auto

+ 0On

RECEIVER 1

-
NE
v

SDQI:I

Lewvel

ouTPUT

ATTH 1
20de -

External

reference

Receiver
Bandwidth

1kHz h

DUT delay

000s

Measurement
period

3.06 mz

RECEIVER 2

[
ATTH 2

20de -

CHZ-RFL

X

(] 8 | Cancel |

Help

Hint: To match the impedance of the directional coupler, the input
resistances of the channel 1 (CH1) and channel 2 (CH2) are set to 50 Q.
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5. Click the Connection Setup tab.

Configuration E |

Device Configuration  Connection Setup |

Bode 1 l)l)/@.%’:

Reflected Power

_"-'_; ¥ One Port DUT
St (e.g. Antenna)

Directional Coupler

Channel 1 External Probe Channel 2 External Probe

QK | Cancel | Help |

The connection diagram shows how to connect the DUT as well as the
directional coupler to the Bode 100.
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6. Connect the directional coupler to the Bode 700 as shown.

7. Click __% | to close the Configuration window and to get back to the
Frequency Sweep (External Coupler) mode window.

8. Set the sweep frequencies:
» Start frequency: 8.7 MHz
+ Stop frequency: 12.7 MHz
* Number of points: 201

The other settings will be automatically calculated and the Sweep area of the

Frequency Sweep (External Coupler) mode window should now look like
below.

Sweep

Start Frequency 'm
Stop Frequency 'm
Center Frequency 'm
Span 4.000 MHz

Sweep Mode m
Mumber of Paints '_‘
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9. Set the reference resistance.
Default: 50 Q

Measurement

Reference Resistance 50.00 &

Hint: The reference resistance is used to calculate the reflection coefficient
and the VSWR.

10.Calibrate the measurement setup as described in 8.6 "Calibration in the
Frequency Sweep (External Coupler) Mode" on page 106.

Hint: Due to the strongly varying parameters of directional couplers a
calibration is mandatory before performing a measurement. If you start a
measurement in the Frequency Sweep (External Coupler) mode without
calibration, the following dialog box appears.

Calibration

1] E Mo calibration data available for this meazurement mode
L

o |ser Calibration... 7%, Probe Calibration... | Cancel |

CAL CAL

In this case, select the User Calibration or the Probe Calibration, and then
proceed as described in 8.6 "Calibration in the Frequency Sweep
(External Coupler) Mode" on page 106.

11.Connect the IF Filter to the Bode 100 and the 50 Q load to the output of the
IF filter as shown below.

IF Filter

W 94v-0
Juartz FilteraEaEs e
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12.Activate both traces and set the parameters as shown below.

Iv¥ Trace1[TR1]

Colar -E|
Meazuremnent W
Dizplay m
Format m
Trnax W

it llm:li

Y-Scale: ™ Lin
" Log TR1
" Log|TR1I

D ata-»Memory

bain | Advanced

v Trace 2 [TR2)

Colar _E'
Meazurement m
Dizplay |Data -
Farmat m

' man lm

it Im

D ata-»Memaory |

Main | Adwanced
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OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help
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|

Gy D
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Level j 0.00 dBm ‘flf ¥ Trace 2(TR2)
Attenuster CH1 |20 dB - 102 | ot
M 10M 1M 12M
Attenuster CH2 [20 dB - fHz Measurement [impedance ~
TR1: VSWR(Reflection ’—L|
Recsiver Bandwidth [1 kHz - L b Display | Data
Format |Folar -
Measurement Ymax |44 Dhm
& ¥
Refersnce Resistance 50.000 il m

Data->Memary

o
Main_| édvanced]
Diagiam Setup
" Auta

45.00 4 & Always Two Disarams

Y 5250 A

Export Traces Data...

TR2: Impedance

[TRL AVG OFF [ TRe: AV6 OFf

In the upper graph you see the reflection of the IF filter in VSWR format. Even
outside its passband the VSWR of the filter is quite good — this indicates that
the input impedance of the filter in the measured frequency range is very
close to 50 Q in general. The lower graphs shows the impedance of the IF
filter in polar format, the so-called polar curve.
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Hint: The effect of noise on the measurement results can be reduced by
narrowing the receiver bandwidth, by using less attenuation in the input
channels and by increasing the signal level of the Bode 100 source output.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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13.Select the Cursor 1 check box to activate the cursor, and then set the cursor
to the IF filter's center frequency of 10.7 MHz by entering 10.7 MHz in the
respective box of the cursor table.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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Result: The VSWR of the IF filter at its center frequency is 1.025. The
impedance graph shows an impedance of 48.796 Q and due to the very small
positive phase shift a nearly pure resistive behavior.
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Sometimes external
couplers help to make a
match and to enhance
the power.

Congratulation! You learned how to use the Frequency Sweep (External Coupler)
mode.

How to:

Connect an external coupler

Set configuration parameters like the input resistor and bandwidth
Calibrate and compensate the connection system

Display reflection in VSWR format

Display impedance in polar format

Remove the effects of noise

Go back to the Frequency Sweep (External Coupler) window in 6 "Frequency
Sweep (External Coupler) Mode" on page 67 and try things out.
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7 Frequency Sweep
(Impedance Adapter) Mode

Figure 7-1:
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Reference Resistance 50.00 02 Format |Phase] =
Ymax [197.80°
150
Ymin [-197.96°
100 Y-Scale: & Lin
- " LogTR2
ﬂ © LoalTR2
0

TR2/

Data->Memary

= Main_| édvanced]
-100
Diagiam Setup
-150 At
& Always Two Disarams
107 10% 10% 10 10% 10°% 107

fiHz

Export T Data...
TR2: Phase{lmpedance) LExport Traces Uata,

[TRL AVG OFF [ TRe: AV6 OFf

Note: The window areas and screen elements in the Frequency Sweep
(Impedance Adapter) mode are the same as in the Frequency Sweep mode.
For their description, see Figure 5-1: "Frequency Sweep mode window" on
page 47.

@ In the Frequency Sweep (Impedance Adapter) mode, you can perform a
sequence of Impedance/Reflection measurements and get a better grip on
your electronic components by using OMICRON Lab impedance adapters for
the Bode 100 (see 1.8 "Additional Accessories" on page 15).

The impedance adapters contain a special circuitry which extends the
impedance measurement range of the Bode 700. By using the adapters, you
can quickly measure electronic components in various mounting forms. The
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B-WIC adapter facilitates measuring of all wired passive components while the
B-SMC adapter is especially designed for connecting even smallest SMD
components.

7.1 Example: Frequency Sweep
(Impedance Adapter) Measurement

Expected example duration: 30 minutes.

In this example you will learn step by step how to use the Frequency Sweep
(Impedance Adapter) mode of the Bode 700.

How to:
» Connect the impedance adapters

» Set configuration parameters like the start and stop frequencies and the
bandwidth

» Calibrate and compensate the connection system
» Display the series inductance in Henry

» Display the series resistance in double logarithmic scale

Let’'s examine the impedance behavior of a wired coil.
Questions:
»  What is the frequency range the coil can be used in?

» Does the coil become capacitive and, if yes, where is its resonance
frequency?

» Does the coil have a series or a parallel resonance?

*  What is the coil’s series resistance?

To find out the answers, proceed as follows:
1. Connect the Bode 100 to the computer and start the Bode Analyzer Suite.

2. Click the Frequency Sweep (Impedance Adapter) toolbar button @ to
switch to the Frequency Sweep (Impedance Adapter) mode.

3. Click the Device Configuration toolbar button %, to configure the
Frequency Sweep (Impedance Adapter) mode.

4. Select the receiver bandwidth: 100 Hz
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X

Configuration

Device Configuration l Connection Setup ]

SOURCE  Auto Receiver

& On FECERER 1 Bandwidth RECEIVER 2

ATTH 1

ATTH 2

DUT delay

000s

Measurement
period

External D689 s
reference

Fror—
@f‘urr [ [1o0H:  ~] [

SDQI:I

Lewvel

ouTPUT

QK | Cancel | Help

Hint: To ensure a wide measurement range the input impedances of the
channel 1 (CH1) and channel 2 (CH2) are set to high impedance.
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5. Click the Connection Setup tab.

Configuration

X

Device Configuration  Connection Setup l

Adapter: ™ ‘wied  SMD

Impedance DUT
(e.g. Resistor)

Impedance Adapter B-WIC

Channel 1 External Probe Channel 2 External Probe

11 hd 11 hd

QK | Cancel | Help

6. The connection diagram shows how to connect the impedance adapter to the
Bode 100. Click Wired for connecting a wired component.

7. Connect the B-WIC impedance adapter to the Bode 100 as shown in the
following figure.

|

8. Click _9 | to close the Configuration window and to get back to the
Frequency Sweep (Impedance Adapter) mode window.
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9. Set the sweep frequencies:
» Start frequency: 10 Hz
» Stop frequency: 40 MHz
»  Sweep mode: logarithmic
*  Number of points: 401

Sweep

Start Frequency 'W
Stop Frequency 'm
Center Frequency IM
Span 39.939390 MHz

Sweep Mode 'W‘
Mumber of Paints '_‘

10.Calibrate the measurement setup as described in 8.7 "Calibration in the
Frequency Sweep (Impedance Adapter) Mode" on page 110.

Hint: To compensate the impedance of the measurement circuitry inside the
impedance adapter a calibration is mandatory before performing a
measurement. If you start a measurement in the Frequency Sweep
(Impedance Adapter) mode without calibration, the following dialog box
appears.

Calibration

! E Mo calibration data available for this measurement mode
L

& User Calibration... 7%, Probe Calibration... | Cancel |

CAL

In this case, select the User Calibration or the Probe Calibration, and then
proceed as described in 8.7 "Calibration in the Frequency Sweep
(Impedance Adapter) Mode" on page 110.
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11.Now, connect the DUT to the adapter’s connectors as shown in the following
figure.

12.Activate both traces and set the parameters as shown in the following figure.

¥ Trace1[TR1)

Caolar _Z‘
Measurement ’W‘
Dizplay ’m
Format | Ls hd
rmax ’W

“rmin ’W

Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

Main | Advanced

¥ Trace 2[TR2)

Caolar _Z‘
Measurement ’W‘
Dizplay |Data -
Farmat ’m
rmax ’W

“rmin ’W

Y-Seale: * Lin
" Log TR2
" LagITR2

[rata-»kemary |

Main | Advanced
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13.Select the Cursor 1 and Cursor 2 check boxes to activate the cursors for
analyzing the measurement curve.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Messurement  Corfiguration  Calbration  Trate  Tools  Help

SHER aspk s @ e HEEER

& User Calibration. . 7% Probe Calibration. . %z Trace Functions... TRL AWG OFF  TRZ AWG OFF T
Sueen Frequency Trace 1 Trace 2 F Tiacel (TR1)
99646 Hz 3,052 mH
Start Frequency 10.000Hz 285,600 KHe 0.040mE coir [
Stop Frequency 40,000 MHz < | Measurement | Impedance =
C— Display [Data -
Center Frequency | 20.000005 MHz ] play
Format [Ls -
&m
Span | 33999990 MHz n Ymax [BT30H
|
Sweep Mode |Logaithmic  + 4m | min |-577 mH
f ¥Seale © Lin
Number of Points | 401 - m " Log TR1
I * Log[TRII
‘ ¥ o
= . Diatar>Memory
Configuration 2m I Main | Advanced |
Level j 13.00 dBm am | WV Trace 2 (TR2)
Recsiver Bandwidth [100 Hz - B
100 0% 10° 10 10° 0% 107 Measurement [Impedance =
Measuement fHz
TR1: Ls{Impedance) Display | Data -
Reference Resistance 60.00G Format |Phase] =
Yinax [197.90°
150
i [197.36
100 ¥Scale & Lin
* Log TRZ
50
. ﬂ " Log|TRZ
5 ]
© IL Data>Memary
= Main_| édvanced]
-100
Diagiam Setup
-150  Auto
& Always Two Disarams
107 10% 10% 10 10% 10°% 107
fiHz
TR2: Phase{lmpedance) EzorillacesDaia

In the upper graph you see the serial inductance of the coil. At lower
frequencies the serial inductance is around 3 mH. The graph shows that the
inductance starts decreasing at a frequency around 1 kHz and shows a
resonance at 385.6 kHz. For frequencies higher than the resonance
frequency, the coil has a capacitive behavior except within a small frequency
range where it gets inductive again. This indicates a parallel resonance as
the inductance is active for low frequencies, while the capacitive part is active
for high frequencies. The small inductive range between 24.5 MHz and
35.1 MHz is easily visible in the phase curve of the coil shown in the lower
graph.
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14.Now, switch the format of trace 1 to Rs to measure the series resistance of

the caoil.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File ~ Measurement  Configuration  Calibration

Trace

Tools

Help

DEE SR as s @ o BHEEERE

[TRL AVG OFF [ TRe: AV6 OFf

& User Calibration... IMPON ’E}Prubec.ahbrauun Fip Trace Funchions. .. TR1 AWG OFF TRZ AVG OFF XJ
Sueen Fraquency Trace 1 Trace 2 ¥ Trace 1 TR}
99,645 Hz 541.419 mQ2
Start Frequency 10.000 Hz 355 6010 ke 5372660 coor =]
Stop Frequency | 40000 MHz \ | Measurement |Impedance
Display [Data -
Center Frequency | 20.000005 MHz ] play
Format [Rs -
Span | 39999390 MHz , Ymax [25.78 kOhm
SweepMode [Logaithme = ¥min ]0.00 Ohm
20000 Y¥-Scale: © Lin
Nurber of Points [401 - c ‘ © LogTR1
‘ § 1o  LogITRII
¥ ‘ D atarsMemorny
=
10000
Gy | Main [Adrced]
Level | 1200 &m 5000 il W Tiace2(TR2)
\
1
Rieceiver Bandwidth [100 Hz - o _j B
100 10®  10°  10¢  10°  10° 107 Measurement [Impedance =
Measurement fHz
TR1: Rs(Impedance) Display |Data -
Reference Resistance 60.00G Format |Phase] =
Ymax [197.80°
150
v 19736
100 YScale: & Lin
o " LogTRZ
. H " Log|TRZ
5 o
© l[ Data>Memary
= Main_| Advanced |
-100
Diagram Setup
-150  Auto
5 Mways Two Diagrams
107 10% 10% 10 10% 10°% 107
fiHz
Rz Praselimpedancer Expart Traces Data...

Hint: The series resistance shown in the upper graph shows a very high
resistance at the resonance frequency. But due to the linear scaling the
graph does not show any detailed information for the rest of the curve.
Therefore we now set the scaling for the Y-axis to logarithmic.
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15.In the trace settings area of the Bode Analyzer Suite window, click Log TR1
to display the graph in the logarithmic Y-axis scale.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File: Measurement Configuration Calibration Trace Tools Help
NEHER Ay D @ e HEEEE
& User Calibration. . IMPON ’E}Prubec.ahbrauun 1 Trace Functions... TR AWG OFF TRZ AVG OFF X))
Sweep Frequency Trace 1 Trace 2 F Tiacel (TR1)
99.646 Hz B41.414 m{)
S iz 10000 H 385,600 kHz 5304k cooe =]
Stop Frequency | 40.000 MHz | | Measurement |Impedance =
Display |Data -
Center Frequency | 20.000005 MHz ] )
Format | Rs -
|
Span | 39999990 MH: e I “Ymay [28.09 kOhm
SweepMode |Logartmic = H\ Yrrin [453.34 mOhm
- 10} / \ YScale: € Lin
MNurmnber of Points - g
= \ & LoaTRI
£ \ 1 ¢ LogITRI
‘ Q1 J l\ i
E / \ | Data->Memory
. . \ / van [Pdvrced]
/
s
Level j 13.00 dBm WV Trace 2 (TR2)
10°
Receiver Bandwidth | 100 Hz Colar
s we e e Measurement [Impedance =]
Measurement fiHz
TR1: Rs(Impedance) Display | Data -
Reference Resistance 50000 -
Ymax [197.90°
150
min [197.36°
100 Y5cale:  Lin
o ¢ LogTR2
. H © LoalTR2
5] ]
= l[ Data>Memory
= Main_| Advanced |
-100
Diagram Setup
-150 At
+ Always Two Diagiams
107 10° 107 10+ 10°% 10% 107
fiHzZ
R Prsse(mpedance) Export Traces Data...

Result: In the upper graph you can now see a better graph of the series
resistance. Due to the logarithmic Y-axis scaling, the graph clearly shows that
the series resistance continuously rises until the maximum resistance is reached
at the resonance frequency. You can also see that after dropping the series

resistance increases again in the high-frequency range in which the coil shortly
becomes inductive again.
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If you adapt yourself to
components you can
characterize them more
easily.

Congratulation! You learned how to use the Frequency Sweep
(Impedance Adapter) mode.

How to:

+ Connect an impedance adapter

» Calibrate and compensate the connection system
» Display the series inductance in Henry

» Display the series resistance in double logarithmic scale

Feel free to go back to the Frequency Sweep (Impedance Adapter) window in
7 "Frequency Sweep (Impedance Adapter) Mode" on page 79 and try things
out.
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8 Calibrating the Bode 100

The Bode 100 can compensate effects of the measurement setup like cables
and probes. Further on the overall accuracy may be improved by calibrating the
Bode 100 (e.g. if the operating temperature is outside the range specified in
13.5 "Environmental Requirements" on page 183).

8.1 Calibration Methods

The Bode 100 supports two calibration methods: the Probe Calibration
optimized for measurements which require frequent changes of measurement
settings and the User Calibration for most accurate results.

Note: During startup, the Bode 100 executes an Internal Calibration algorithm.
During this calibration, internal attenuators and amplifiers are measured and
calibrated.

8.1.1 Probe Calibration

~ mepecaibraton.. 1 NE Probe Calibration of the Bode 700 allows you to change several
measurement parameters without the need of recalibration. During the
Probe Calibration, calibration factors are determined at factory defined
frequencies within the complete frequency range. The calibration factors for the
frequency points used by the current measurement settings are then obtained
by linear interpolation.

Hint: The Probe Calibration compensates effects of cables and broad-band
probes. If you want to compensate frequency selective probes or if your cable
length exceeds 10 m it is recommended to use the User Calibration (see
8.1.2 "User Calibration" on page 90).

The Probe Calibration allows changing the following parameters without the
need of recalibrating the Bode 100:

* Frequency values

+  Sweep mode (linear/logarithmic)

*  Number of measurement points (in the Frequency Sweep modes)
+ Source level

+ Attenuator 1 and attenuator 2

* Receiver bandwidth

» Zoom with & without the Copy from Zoom function
(see "Copy from Zoom" on page 131)
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8.1.2

4 User Calibration. ..

The Probe Calibration will be switched off automatically if the following
parameters are changed:

» Reference mode (internal/external reference)
» Conversion ratio of external probes (see 10.9 "Using Probes" on page 171)
» Input resistance of channel 1 and/or channel 2 (low/high impedance)

Hint: Use the Probe Calibration if measurement parameters have to be
changed often during the measurements. You will save time because you do not
need to recalibrate the Bode 700 each time you changed the parameters.

User Calibration

The User Calibration is the most accurate calibration method available with the
Bode 100. The User Calibration is performed directly at the exact
measurement frequencies. In the Gain/Phase and Impedance/Reflection
measurement modes, the Bode 100 is calibrated at the source frequency. In the
Frequency Sweep modes, the calibration is performed at the exact frequencies
specified by the measurement points.

The User Calibration allows changing the following parameters without the
need of recalibrating the Bode 100:

» Source level

» Attenuator 1 and attenuator 2

* Receiver bandwidth

+ Zoom without the Copy from Zoom function (see "Copy from Zoom" on
page 131)

The User Calibration will be switched off automatically if one of the following

parameters is changed:

» Frequency values

+ Sweep mode (linear/logarithmic)

* Number of measurement points (in the Frequency Sweep modes)

» Reference mode (internal/external reference)

» Conversion ratio of external probes (see 10.9 "Using Probes" on page 171)

* Input resistance of channel 1 and/or channel 2 (low/high impedance)

+ Zoom with the Copy from Zoom function (see "Copy from Zoom" on
page 131)
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Hint: Use the User Calibration for the highest accuracy of measurement
results or if you want to compensate for highly frequency selective components
in your measurement setup such as narrow-band measurement probes.

8.1.3 Hierarchy of Calibration Methods

The following table gives an overview of the Bode 100 calibration methods.

Table 8-1:
Calibration methods

Measurement Mode |User Calibration Probe Calibration

Gain/Phase Calibrates the complete
frequency range.
Calibration factor for the

Calibrates at only one
frequency

Impedance/Reflection (measurement frequency) gig?::gpezn;;rigggrcy
interpolation.
Frequency Sweep Calibrates the complete

frequency range.
Calibration factors for the
measurement frequencies
are calculated by linear
interpolation.

Frequency Sweep | Calibrates at the exact
(External Coupler) | frequency points used for
Frequency Sweep  |the sweep

(Impedance Adapter)

You can activate the User Calibration and the Probe Calibration at the same
time as shown below.

Figure 8-1:

Activating & User Calibration... IMP OFF | 7% Probe Calibration. . IMF OFF

User Calibration and ) ]

Probe Calibration If both the User Calibration and the Probe Calibration are activated, the more

accurate User Calibration is used. If measurement parameters are changed
and the User Calibration becomes void the Bode 100 switches automatically to
the Probe Calibration; the User Calibration remains switched off until the
Bode 100 is recalibrated.

8.2 Calibration in the Gain/Phase Mode
(Internal Reference Connection)
For calibrating the Bode 700 in the Gain/Phase mode you find a practical
example in 3.3 "Example: Gain/Phase Measurement" on page 26.

Note: The Probe Calibration is performed in the same way as the
User Calibration.
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8.3 Calibration in the Gain/Phase Mode
(External Reference Connection)
To compensate for the cable and connection setup effects in the Gain/Phase
mode, proceed as follows:

1. Connect the Bode 100 and start the Bode Analyzer Suite.
Select the Gain/Phase mode.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

File ~ Measurement  Configuration  Calibration  Trace  Tools  Help
NEHER e[ @ o (EEEEE
o User Calibration... ’:;§ Frobe Calibration. . Xz =
Source Result
Source Frequency ‘ 1.110MHz ‘Mag [dB] j | -97.263 dB
[Phase [7] =l 30822°
Configuration
Level 0.00 dBm
5
Atteruator CH1 | 20 dB hd
4
Alteruator CH2 |20 4B hd 3
Receiver Bandwidth |1 kHz hd 2
1
0 v
-1
-2
3
-4
-5
4 2 o 2 4
[ |

2. Click the Device Configuration toolbar button %, to open the
Configuration window.
In the Configuration window, set the parameters for your measurement. In
our example we have chosen the following settings.
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3. Set:

+ SOURCE: 10.7 MHz

+ SOURCE: On or Auto

* Receiver bandwidth: 10 Hz
+ ATTN 1:20dB

+ ATTN 2:20dB

* Level: 0dBm

X

Configuration

Device Configuration l Connection Setup ]

SOURCE

" Auto Recsiver
WHOMHz & g RECEIVER 1 B ondnidth RECEIVER 2

O I 10Hz - I
@ ATTH 1 ATTH 2
20de - DUT delay 0dE -
\ 0.00s

Measurement
period

Eternal — op5 54 ms
reference

SDQI:I

Lewvel

0.00 dBm

OuTPUT CH1
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4. Click the Connection Setup tab.

Configuration rX

Device Configuration  Connection Setup l

Thru Cable
or Probe

Two Port DUT
Channel 1 External Probe Channel 2 External Probe
11 hd 11 hd
o | oo |

The connection diagram shows how to connect the DUT to the Bode 100.
5. Connect the cables you want to use for the measurement as shown below.

6. Click __9 | to close the Configuration window.

7. Choose either the Probe Calibration or the User Calibration and click the
respective toolbar button.
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8. In the respective calibration window, click the Start button next to Thru to
calibrate the Bode 100.

User Calibration - Gain/Phase

Gain/Phase
Feplace DUT by thru cable. Afterwards press Start to perfom

Calibration.
Thru Start Perfarmed

Impedance
Advanced

INNERRRENRENENENNEEEEN
QK | Cancel | Help |

Note: In the Gain/Phase mode, no Impedance calibration is possible.

The Gain/Phase mode is now calibrated for the current specific
measurement setup. Refer to 8.1 "Calibration Methods" on page 89 to learn
in which cases you have to repeat the calibration if a parameter is changed.

9. Click _ o |.

OMICRON Lab, - Bode Analyzer. Suite - NewBodeMeasurement.Bode

File  Measurement  Configuration — Calibration  Trace  Tools  Help
DESHE &R AN [P o o HEEEME
4 User Calibration. .. ’g;% Probe Calibration. .. i
Source Result
Source Frequency 10.700 MHz |Mag [dE] j | -126.184 pdB
|Phase [ = | 0000
Configuration

In our case we read —126 pdB (-0.000126 dB) and 0.000°. Because we are
close to zero your results may differ from this example. Nevertheless the
displayed values should be very small.
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10.The calibration is done and you can replace the BNC straight adapter with
your DUT as shown below.
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8.4 Calibration in the Impedance/Reflection Mode

By calibrating the Bode 100 you can remove the effects of the connection setup
on the accuracy of the measurement results in the Impedance/Reflection
mode. Without calibration the reference plane of the impedance measurements
is at the BNC connector of the Bode 7100 source output. Therefore if a DUT is
connected through a cable, the measured impedance is the combination of the
cable's impedance and the DUT's impedance. By calibrating the Bode 100 you
can move the reference plane for the impedance measurement to the end of the
connection cable and fully remove the influence of the cable.

In the Impedance area of the calibration window, you can set the resistance of
the load resistor and the short delay time as shown below.

User Calibration - Impedance

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed
Load Start _

Enter the exact

[£] Advanced resistance of the load
Load Resistor [50.00 2 — " used for calibration
Factory setting: 50 Q2

Enter the delay time of
the short circuit used for
calibration ——— Shert Dela Time |50.00ps
Factory setting valid for
the short circuit delivered

with the Bode 700: 50 ps | HENNENEENNNNNENEEENNEEN
QK | Cancel | Help |
Hint: If the entered values of the load resistor and/or the short delay time differ

from the factory settings a yellow warning symbol appears after the Advanced
area has been collapsed.

Example: Measure the input impedance of the IF filter at the BNC connector of
the PCB (and not the impedance at the input of the cable connecting the filter).

Expected example duration: 20 minutes.

In this example you will learn step by step how to use the calibration of the
Bode 100 in the Impedance/Reflection mode.
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How to:

» Eliminate the effect of the cable

» Connect the cable in the open, short and load condition
» Connect the DUT

Questions:

+  Whatis the real part of the impedance in Q?

*  What is the reflection coefficient in dB?

To find out the answers, proceed as follows:
1. Click the Impedance/Reflection toolbar button [ to switch to the
Impedance/Reflection mode.

2. Click the Device Configuration toolbar button %, to open the
Configuration window.

3. Because we want to test the 10.7 MHz IF filter, set:
+ SOURCE: 10.7 MHz
+ SOURCE: On or Auto
* Receiver bandwidth: 10 Hz
*+ Level: 0dB
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X

Configuration

Device Configuration l Connection Setup ]

it £ futo RECEIVER 1 Receiver RECEIVER 2
10.700 MHz *+ On Bandwidth

@ o I 10Hz = I

ATTH 1 ATTH 2

%7 20de - DUT delay 20dE -

000s

Measurement
period

Internal 265.24 ms
reference

SDQI:I

Lewvel

0.00 dBm

ouTPUT

QK Cancel Help

4. Click __|.

5. Choose either the Probe Calibration or the User Calibration and click the
respective toolbar button.

User Calibration - Impedance

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Advanced

QK Cancel Help
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6. Connect the cable you want to use for the measurement to the OUTPUT
connector of the Bode 100. Plug the BNC straight adapter on the other end
of the cable to have the same reference plane for calibration.

7. Click the Start button next to Open in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Open Start Performed

8. Plug the BNC short circuit on the straight adapter connected to the cable.

Hint: If you use a short circuit other than the one delivered with your
Bode 100 you can enter the short delay by clicking the + symbol next to
Advanced and typing the short delay time.

9. Click the Start button next to Short in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Short Start Perfarmed
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10.Replace the BNC short circuit with the BNC 50 Q load.

11.For very accurate measurements or if you use a load resistor different from
50 Q, click the + symbol next to Advanced, and then enter the exact
resistance of the load resistor.

12.Click the Start button next to Load in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Load Start Perfarmed

13.After the calibration has been finished, the calibration window looks like
shown below.

User Calibration - Impedance

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed
Load Start Perfarmed

Advanced @

QK | Cancel | Help |
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Hint: If the entered values of the load resistor and/or the short delay time
differ from the factory settings a yellow warning symbol appears after the
Advanced area has been collapsed.

14.Click __2 |, You have done the Impedance calibration.

15.0pen the Configuration window by clicking the Device Configuration
toolbar button %, to see how to connect your DUT to the Bode 100.

Configuration [z

Device Configuration  Connection Setup l

w Termination

I
: Twao Port DUT
\
T = = = —
One Port DUT
I I
(] 8 | Cancel |

16.Connect the test object.

IF Filter
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Note: The IF filter is a two-port device. To ensure that the impedance of the
filter is measured correctly, its output must be terminated. For measuring a
one-port device like a capacitor or an inductor, no termination resistor is

needed.
17.Read the results.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Ele Measurement Corfiguration Calbration  Trare  Tools  Help

DEH @ 2. @ o EEREE

& User Calibration, ., 2% Prabe Callbration, . Rz %
Source Impedance Admittance Rieflection
Source Frequency | 10,700 MHz [Real ] | 5030502 [Real > [ 19878ms [Magiam) =] [ 487358
S [Imag | [ amezsEmn [Imag = TS [Prasery =] | 06
10

Attenuator CHT | 20 dBt > P
Attenuator CH2 | 20 dBt >
c

Level 0.00 dBm 100 ‘ i) ‘

Receiver Bandwidth |10 Hz -
=l - - -
Measurement o =0 ar
Reference Resistance 80.00C o s
Serial equivalent circuit Parallel equivalent circuit
Rs=503050 Rp =50.306 ©
B T
Ls=3038rH Lp=184.291 pH
@ =4.060m @ =4.060m

Answers:
* The real part of the impedance is 50.3 Q.
» The magnitude of the reflection coefficient is —48.7 dB.

Your results may differ because every IF filter and measurement setup is slightly
different.
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| had my first cable

problem when | was
born but luckily the

midwife solved that

problem.

Congratulation! You learned the calibration of the Bode 100 in the
Impedance/Reflection mode.

How to:

+ Eliminate the effect of the cable

» Connect the cable in the open, short and load condition
» Connect the DUT
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8.5 Calibration in the Frequency Sweep Mode

In the Frequency Sweep mode, you can perform Gain/Phase and
Impedance/Reflection measurements. Therefore both the Gain/Phase and the
Impedance calibration are available. The actually performed measurements
depend on the measurement type assigned to Trace 1 and Trace 2.

¥ Trace1[TR1)
color NN - |
(Measurement |Gain hd

Dizplay |Data hd
Format ’W‘
rmax ’W
“min |-100.00 dB

Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

Main | Advanced

¥ Trace 2[TR2)

Caolar _Z‘
(Measurement |F|ef|ec:ti0n j)
Dizplay |Data j
Format ’W‘

rmax ’W

“rmin ’W

Y-Seale: * Lin
" Log TR2
" LagITR2

[rata-»kemary |

Main | Advanced

To perform the Gain/Phase calibration in the Frequency Sweep mode,
proceed as described in 3.3 "Example: Gain/Phase Measurement" on page 26
or if you use an external reference proceed as described in 8.3 "Calibration in
the Gain/Phase Mode (External Reference Connection)" on page 92. For the
Impedance calibration, see 5.2 "Impedance Calibration" on page 62.

Hints:

The calibration time for the User Calibration depends on the number of
measurement points and the selected receiver bandwidth.

The calibration time required for the Probe Calibration depends only on the
selected receiver bandwidth.
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8.6

When working with the Bode 100 at frequencies below 10 Hz, the calibration can
take quite long.

Calibration in the Frequency Sweep
(External Coupler) Mode

By calibrating the Bode 100 in the Frequency Sweep (External Coupler)
mode you remove the effects of the connection setup including the external
coupler and, if used, the amplifier on the accuracy of the measurement results.
Due to the strongly varying parameters of directional couplers a calibration is
mandatory before performing a measurement.

In the Frequency Sweep (External Coupler) mode, you can perform only
Impedance/Reflection measurements. Therefore only the Impedance
calibration is available in this mode.

Hint: Some directional couplers show nonlinear behavior at the edges of their
passband. If your measurement frequency range is close to such nonlinearities,
we recommend to use the User Calibration to remove the nonlinear effects.

To calibrate the Bode 100 in the Frequency Sweep (External Coupler) mode:
1. Click the Frequency Sweep (External Coupler) toolbar button (¥ to switch
to the Frequency Sweep (External Coupler) mode.

2. Click the User Calibration toolbar button : & User caltration... to open the
calibration window.

User Calibration - External Coupler

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Advanced

QK Cancel Help
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3. Plug the BNC straight adapter on the end of the cable.

4. Click the Start button next to Open in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Open Start Performed

5. Plug the BNC short circuit on the straight adapter connected to the cable.

6. Click the + symbol next to Advanced, and then enter the short delay time
(only if you use a short circuit other than the one delivered with your
Bode 100).

7. Click the Start button next to Short in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

Short Start Perfarmed
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8. Replace the BNC short circuit with the BNC 50 Q load.

9. For very accurate measurements or if you use a load resistor different from
50 Q, enter the exact resistance of the load resistor in the respective box in
the Advanced area of the calibration window.

10.Click the Start button next to Load in the Impedance area of the calibration

window. After the calibration has been finished, the field on the right displays
Performed on green background.

Load Start Perfarmed
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11.After the calibration has been finished, the calibration window looks like

shown below.
User Calibration - External Coupler

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed
Load Start Perfarmed

Advanced

INNERRRENRENENENNEEEEN
QK | Cancel | Help |

Hint: A yellow warning symbol displayed close to Advanced indicates that
the short delay and/or the load resistance entered in the Advanced area
differ from the factory settings.

12.Click __% __|. You have done the Impedance calibration in the
Frequency Sweep (External Coupler) mode.
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8.7

Calibration in the Frequency Sweep
(Impedance Adapter) Mode

By calibrating the Bode 700 in the Frequency Sweep (Impedance Adapter)
mode you remove the effects of the connection setup on the accuracy of the
measurement results. To measure the impedance of a DUT connected to the
impedance adapter the calibration point needs to be at the impedance adapters
connectors. Therefore calibration is mandatory before performing a
measurement.

In the Frequency Sweep (Impedance Adapter) mode, you can perform only
Impedance/Reflection measurements. Therefore only the Impedance
calibration is available in this mode.

To calibrate the Bode 7100 in the Frequency Sweep (Impedance Adapter)
mode:

1. Click the Frequency Sweep (Impedance Adapter) toolbar button @ to
switch to the Frequency Sweep (Impedance Adapter) mode.
2. Click the User Calibration toolbar button : & User caliration... or the

Probe Calibration toolbar button : < Frebe caltrstion. . to open the corresponding
calibration window.

User Calibration - Impedance Adapter

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Advanced

QK Cancel Help
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3. Connect the impedance adapter used for the measurement to the Bode 700.

4. If you use the B-SMC impedance adapter, separate its DUT connectors by

using the small jumper delivered with the adapter as shown in the following
figures.
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5. Click the Start button next to Open in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays

Performed on green background.

User Calibration - Impedance Adapter

— Gain/Phaze
Heplacz_e DUT by thru cable. Afterwards prezz Start to perfom

Calibration.

— Impedance
Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start | Performed

Advanced

([
QK | Cancel I Help |

6. Short-circuit the DUT connectors of the impedance adapter.

For the B-WIC impedance adapter use the delivered short circuit.

Hint:
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7. Click the Start button next to Short in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays
Performed on green background.

User Calibration - Impedance Adapter

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed

Advanced

INNERRRENRENENENNEEEEN
QK | Cancel | Help |
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8. Connectthe 100 Q load resistor delivered with the impedance adapter to the
DUT connectors as shown in the following figures.
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9. For very accurate measurements or if you use a load resistor different from
100 Q, enter the exact resistance of the load resistor in the respective box in

the Advanced area of the calibration window.

User Calibration - Impedance Adapter

Gain/Phase

e | e

Impedance
Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed

Short Start Perfarmed

=] Advanced
C Load Resistor |100.00 G2 )

Short Delay Time [0.00 s

INNERRRENRENENENNEEEEN
QK | Cancel | Help

10.Click the Start button next to Load in the Impedance area of the calibration
window. After the calibration has been finished, the field on the right displays

Performed on green background.

User Calibration - Impedance Adapter

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed
Load Start Perfarmed

Advanced

INNERRRENRENENENNEEEEN
QK | Cancel | Help |
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Hint: A yellow warning symbol displayed close to Advanced indicates that
the short delay and/or the load resistance entered in the Advanced area
differ from the factory settings.

User Calibration - Impedance Adapter

Gain/Phase

e | e

Impedance

Connect the comesponding part and perform the calibration
by pressing the start button,

Open Start Performed
Short Start Perfarmed

[+] Advanced @
INNERRRENRENENENNEEEEN

QK | Cancel | Help |

11.Click __% __|. You have done the Impedance calibration in the
Frequency Sweep (Impedance Adapter) mode.
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9 Common Functions

In this section you can find the Bode Analyzer Suite basics. The section
provides an overview of the toolbars, menus and commands common to all
measurement modes. Further on, this section explains how to change the
measurement range, how to select the measurement speed, how to export the
data, and how to store and load configuration files.

9.1 Toolbars, Menus and Commands

Figure 9-1:
Toolbar Search and Reconnect Device Gain/Phase
Continuous Measurement Frequency Sweep
New Print Single Measurement
b 5l |5 - § @ T Y
Open Contents
Save Device Configuration | High Speed/ Impedance/
Full Speed Mode Reflection
Print Preview
Stop Measurement  Frequency Sweep _|
(External Coupler)
Frequency Sweep ]
(Impedance Adapter)
Figure 9-2:
Calibration and trace User Calibration Probe Calibration Trace 1 Functions On/Off
functions toolbar
Probe Impedance Reset Trace
Calibration On/Off Functions
& User'Calibration. .. o, ProbelCalibration. . Xz
User Impedance Trace Functions
Calibration On/Off
User Gain/Phase Probe Gain/Phase Trace 2 Functions On/Off
Calibration On/Off Calibration On/Off
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Table 9-1:
File menu

Table 9-2:
Measurement menu

Command Description

1 New Opens the NewBodeMeasurement.Bode file
containing default settings.

= Open Opens a .Bode file containing saved settings

= Lp and measurement data.

= Save Saves the device configuration, measurement
settings, calibration and measurement data and

Save As the graphical display settings.

Prints a report containing the diagram,

i Print measurement results, and device configuration

data.

/| Print Preview

Previews the print report.

Exit

Enables you to exit the Bode Analyzer Suite.

Command

Description

B Gain/Phase

Selects the Gain/Phase measurement mode.

& Impedance/Reflection

Selects the Impedance/Reflection
measurement mode.

5 Frequency Sweep

Selects the Frequency Sweep measurement
mode.

Frequency Sweep
%]
(External Coupler)

Selects the Frequency Sweep
(External Coupler) measurement mode.

@ Frequency Sweep
(Impedance Adapter)

Selects the Frequency Sweep
(Impedance Adapter) measurement mode.

Continuous
Measurement

Starts a continuous measurement.

M Single Measurement

Starts a single frequency sweep measurement.’

@ Stop Measurement

Stops a measurement. The last result remains
displayed.

High Speed/
Full Speed Mode

Toggles between the High Speed and
Full Speed mode (see 9.3 "Selecting the
Measurement Speed" on page 120).

1.

Only available in the Frequency Sweep modes
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Table 9-3:
Configuration menu

Table 9-4:
Calibration menu

Table 9-5:
Trace menu

Table 9-6:
Tools menu

Table 9-7:
Help menu

Command

Description

%, Device Configuration

Opens the Configuration window for
configuring the Bode 100.

Connection Setup

Shows the connection of the DUT to the
Bode 100.

&3 Search and
Reconnect Device

Reconnects the Bode 7100 with the computer.

Command

Description

A User Calibration

Starts the User Calibration
(see 8 "Calibrating the Bode 100" on page 89).

"% Probe Calibration

Starts the Probe Calibration
(see 8 "Calibrating the Bode 100" on page 89).

Command

Description

¥z Trace Functions

Opens the Trace Functions — Settings dialog
box for setting the parameters of trace functions
(see 10.4 "Using the Trace Functions" on

page 147).

%) Reset Trace Functions

Resets the trace functions (see 10.4 "Using the
Trace Functions" on page 147).

Command

Description

Options

Opens the Options dialog box for setting the
options (see 9.2 "Setting the Measurement
Range" on page 120, 9.4 "File Operations" on
page 121, and 9.4.1 "Loading and Saving the
Equipment Configuration" on page 121).

Command

Description

& Contents

Starts the Bode Analyzer Suite Help.

&% Bode 100 Web site

Opens the OMICRON Lab Web site
www.omicron-lab.com.

About

Displays the Bode Analyzer Suite version.
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9.2

Figure 9-3:
Setting the
measurement range

9.3

Table 9-8:
Selecting the
measurement speed

Setting the Measurement Range

With the Bode 100 you can perform measurements within 10 Hz...40 MHz
(default frequency range) and 1 Hz...40 MHz (extended frequency range). To
select the measurement range, click Options on the Tools menu, click the
Measurement tab, and then select the frequency range for your measurement.

Options g|
Startup Configuration  Measurement l C5Y Export]
Measurement

@ + Measurement Range 10 Hz - 40 MHz
" Measurement Range 1 Hz - 40 MHz

[increazed calibration time]

QK | Cancel | Help |

Selecting the Measurement Speed

You can operate your Bode 100 in the High Speed and Full Speed mode. By
default, the Bode Analyzer Suite starts in the High Speed mode. The High
Speed mode is recommended for measurements where you have to expect
distortions from the DUT.

The Full Speed mode increases the Bode 100 measurement speed. In the Full
Speed mode, the sweep times are reduced considerably especially at low
receiver bandwidths and at low measurement frequencies.

Measurement Speed |Action

Full Speed mode Click the High Speed/Full Speed Mode toolbar

button or the High Speed/Full Speed Mode
command on the Measurement menu.

High Speed mode Click the High Speed/Full Speed Mode toolbar
button or the High Speed/Full Speed Mode

command on the Measurement menu
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9.4 File Operations

The Bode 100 supports the following file operations.

9.4.1 Loading and Saving the Equipment Configuration

You can store all settings of the Bode 100 including the device configuration,
measurement settings, calibration and measurement data and the graphical

display settings by clicking the Save toolbar button | (see Table 9-1: "File
menu" on page 118).

Hint: This functionality allows you to store multiple equipment configurations for
repetitive measurement tasks. With the equipment configurations stored, you
can load the respective files for each measurement instead of setting the
Bode 100 manually.

A saved file containing the Bode 700 settings has the .Bode extension. The file
is stored in XML format and can be viewed with standard Web browsers or a
simple text editor tool.

After loading a .Bode file the stored measurement data is displayed. To preserve
these values, the measurement is held (the Stop Measurement toolbar

button @ is activated). In this state you can change display options and use
cursors to read measurement data. To start a measurement with the loaded
configuration and settings, click the Continuous Measurement toolbar

button .

Hint: To ensure that the Bode 100 starts with the same configuration as in your
last session, click Options on the Tools menu, click the Startup Configuration
tab, and then select Settings from last session.
Figure 9-4:
Setting the startup
configuration

Options g|
Startup Configuration ] Measurement | CSY Expart |

Startup Configuration

@ " Load Default Settings

+ Settings from last session

QK | Cancel | Help |

Hint: If you have selected Settings from last session the calibration settings
of you last session are NOT loaded. This is done on purpose since your
measurement setup might have changed since you last used the Bode 100. If
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9.4.2

Figure 9-5:
Displayed CSV file data

you want to load measurement settings including the calibration data, use the
Bode 100 file functions (see 9.4.1 "Loading and Saving the Equipment
Configuration" on page 121). However, we recommend to recalibrate the
Bode 100 each time you start a new work session.

Exporting Measurement Data

In all frequency sweep modes (>, ] and [&]), you can export the

measurement data by clicking the button. In addition to
the trace (measurement) data, all equipment settings are exported into a comma
separated .csv file. This file format can be easily processed by standard spread-

sheet analysis tools such as Excel®. The .csv file always contains the real and
the imaginary part of the measured parameter (e.g. gain). Additionally, the
measurement data in the selected output format is included.

Export Traces Data...

.@ = B R L 100427_CSVexport_IFfilter.csv - Microsoft Excel e it
] .
Home | Insert  Pagelayout  Formulas  Data  Review  View  Adddns  Acrobat @ - =
= -l : =S = = :
* ) e E— = General B} conditional Formatting = 5= Insert = ? \ﬁ
=—I g3 |'$ = % | % Format as Table - % Delete - | [g] ™
aste E [ A -] — - o __ Sortd Find &
e g ([BiL D[ S — = g 55 cell stytes - [EIFormat + | &~ Fiter- Select~
Clipboard Font = Alignment % Number Styles Cells Editing
\ R24 - £
A B & D E

1 |---Measurement Setup:

2 |Device Type: Bode100 Serial Number: CK177C Date: 4/27/2010 Time: 11:29 AM

3 |Start Frequency: 10.000 MHz Stop Frequency: 11.500 MHz Number of Points: 401 Sweep Mode: Linear Reference Resistance: 50.00 OF
4 |Source Level: 8.50 dBm Receiver Bandwidth: 1kHz Reference Signal: SourceVoltage Attenuator CH1:20dB Attenuator CH2: 20 dB

5

6 |Frequency (Hz) TR1: Gain (Real) TR1: Gain (Imag) TR1: Gain (dB)

b 10000000 9.33E-06 1.15E-05 -96.60731336

8 10003750 2.74E-05 1.96E-06 -91.21655911

9 10007500 1.84E-05 6.89E-06 -94.13590539

10 10011250 -3.49e-06 1.35E-05 -97.11576564

11 10015000 2.96E-06 1.46E-05 -96.56593414

12 10018750 -9.08E-06 1.27e-06 -100.7497379

13 10022500 2.54E-05 1.58E-05 -90.48951491

14 10026250 3.37e-05 1.15E-05 -88.97996988

15 10030000 5.43€-05 4.57e-07 -85.31074865

16 10033750 2.67E-05 1.45E-05 -90.34793514

17 10037500 4.04E-05 5.94E-06 -87.77771872

18 10041250 7.38E-06 1.71E-05 -94.58396443

19 10045000 1.50E-05 1.48E-05 -93.51799247

20 10048750 3.81E-05 9.19e-06 -88.13388058

21 10052500 3.45E-05 3.42E-05 -86.27164694

22 10056250 9.09e-05 1.53E-05 -80.71211482

23 10060000 5.84E-05 1.62E-05 -84.35237089

4 4 » | 100427_CSVexport_IFfilter <7 s -
Ready | EIE] ] ()2
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To adapt the .csv file to your requirements, you can choose between different
decimal and value separators. To select the separators you want to use, click
Options on the Tools menu, click the CSV Export tab, and then select the
decimal and value separators.

Figure 9-6:
Selecting the B tion: X

separators =)

Startup Configuration ] Measurement TSV Export l
C5Y Export

Decimal Separator |, -
Walue Separator . hd

QK Cancel Help
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10

10.1

10.1.1

Figure 10-1:
Gain/Phase and
Impedance/Reflection
mode shortcut menu,
Grid Cartesian
selected

Advanced Functions

The Bode 100 provides additional features extending the Bode Analyzer Suite
functionality described in sections 3 to 9 of this User Manual. This section
describes these advanced functions which will make your daily measurement
tasks with the Bode 100 even easier.

Advanced Display Options

In all measurement modes, the Bode Analyzer Suite provides several
possibilities to visualize the measurement results according to your needs. You
can control these advanced display options through the shortcut menus and/or
buttons in the main window.

Gain/Phase and Impedance/Reflection Mode

The shortcut menu in the Gain/Phase and Impedance/Reflection mode is
shown below. To open the shortcut menu, right-click a diagram in the graphical
display.

4 Zoom Mode
Optimize
3 Reset Axes

Grid Polar

Copy
Copy with Settings
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Figure 10-2:
Gain/Phase and
Impedance/Reflection
mode shortcut menu,
Grid Polar selected

80"

Zoom Mode
Optimize
Reset Axes

Grid Cartesian

Copy
Copy with Settings

180" b 2 3 4 v
-135° -45°
-80°
Optimize The Optimize command allows you to optimize the diagram by scaling both

axes so that you can see the complete measurement result in the highest
possible resolution.

Figure 10-3:
Diagram with default
settings 5

126



Advanced Functions

Figure 10-4:
Diagram after applying
Optimize
150u
100u
50u
0
-50u
-100u
-150u
-150u -100u -50u 0 50u 100u 150u
Reset Axes The Reset Axes command resets both axes of the diagram to the default

values.
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Zoom Mode

Figure 10-5:
Selecting zoom area

Copy

Copy with Settings

After clicking Zoom Mode, the pointer changes to a magnifying glass when you
move it over the diagram. Press and hold the left mouse button to select the
zoom area. After releasing the left mouse button, the diagram is rescaled to
display the zoomed area.

150u

100u

50u

-B0u '%

-100u

-150u

-150u -100u -B0u o 50u 100u 150u

To switch off the zoom mode, right-click in the diagram, and then click
Zoom Mode to cancel the selection.

To zoom out, right-click in the diagram, and then click Reset Axes. To optimize
the graphical display, right-click in the diagram, and then click Optimize.

By clicking Copy you copy the complete diagram to the clipboard. Thereafter
you can insert the diagram into all Windows™ software applications which
support the insertion of graphical clipboard content.

By clicking Copy with Settings you copy the complete diagram as well as all
relevant equipment settings to the clipboard. From there you can insert the data
into all Windows® software applications which support the insertion of graphical
clipboard content. Depending on the chosen Windows® application, the
clipboard content is inserted as a graphic (e.g. Microsoft Paint), an editable text
(e.g. Microsoft Notepad) or a graphic plus the settings in editable text format
(Microsoft Word).
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10.1.2

Figure 10-6:
Frequency Sweep,
Frequency Sweep
(External Coupler),
and Frequency Sweep
(Impedance Adapter)
mode shortcut menu

Zoom Mode

Figure 10-7:
Selecting the zoom area

Frequency Sweep Modes

The shortcut menu in all frequency sweep modes (B, B and [&) is shown in
the following figure. To open the shortcut menu, right-click the diagram in the

graphical display

Zoom Mode
Optimize

Reset Axes

f-Axis

Copy
Copy with Settings

-

Optimize
Reset

For the Reset, Optimize, Copy and Copy with Settings commands, see
10.1.1 "Gain/Phase and Impedance/Reflection Mode" on page 125.

By using the Zoom Mode command, you can select a zoom area for an in-depth
display of a part of the diagram. The zoom function is a nice way to inspect
particular parts of the measurement curve without having to change the

measurement parameters.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help

DEEER =y . @ @ EBEEEE
GAIN OM X, Probe Calibration. ..

& User Calibration. ..

;¢ Trace Funchions. .. TR1 AWG OFF TRZ AWG OFF @

Frequency
11.997064 MHz
12.020550 MHz

23.486 kHz

Sweep

Cursor 1

Start Frequency 11.980 MHz
Stap Frequency 12,040 MHz

delta C2C1

Trace 1

Trace 2
-0.966 dB
-83.895 dB
-82.930 dB

Center Frequency T200MHz [

Span £0.000 kHz o

Sweep Mode | Linear - —m
Number of Paints |401 - //

‘ [
-30

Configuration

-a0

Level j 0.00 dém
Attenuator CH1 | 20 dB - 50
Attenuator CH2 | 20 dB -

Receiver Bandwidth |1 kHz -

TR1/dB

-60

-70
Measurement

Reference Resistance 50.00 02 -80

11.98M 11.99M

TR1: Mag(Gain)

12.00M 12.02M 12.03M 12.04M
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Figure 10-8:
Displaying the zoom
area

X-Axis, Y-AXxis

OMICRON Lab - Bode Analyzer Suite - NewBo ‘kaMeﬂsummenl.Hnde

Fle  Measurement  Configuration  Calibration

& User Calibration. ..

Trace

DEHER ek @ e BEEER

Tools  Help

7% probe Calibration, .,

%y Trace Functions...

TR1 AWG OFF  TRZ AWG OFF @

Sweep

Statt Frequency | 11,980 MHz
Stop Frequency | 12040 MHz
Conter Fraquency | 12010 MHz
Span | GLODDKHz
SwespMode [Linear |
Mumber of Points 401 =]

Capy from Zaom \

Configuration

Leve\j 0.00 dBm
Ateruster CH1 [20d8 =]
Aterustor CH2 [20d8 =]

Receiver Bandwidth [1kHz |

Measurement

Reference Resistance 50.00 02

[ TRIZ AVG Off [ TR2: AVG Off

Frequency Trace 1 Trace 2
[MCusor] | 11.9%6568 MHz 0770 dB
12.020550 MHz -90.286 B
delta C2C1 23583 kHz 79516 B
[ vl v
]
=
. /N
4 N,
s

TR1/dB

-30

-35

11.980M

11.982M

TR1: Mag(Gain)

11.994M

11.996M
fiHz

11.9%6M

12.000M

12.002M 12.004M

In the Zoom Mode, the measurement is still performed in the whole frequency
sweep range (span); the zoom area applies only to the graphical display.
(Compare the sweep settings in Figure 10-7: "Selecting the zoom area" and
Figure 10-8: "Displaying the zoom area" above — they are identical.)

To optimize the graphical display in both axes, right-click in the diagram, and
then click Optimize. Alternatively, you can reset the axes separately by using
the X-Axis and Y-Axis commands.

To optimize or reset an axis, right-click in the diagram, point to X-Axis or Y-Axis,
and then click the respective command to optimize or to zoom out the selected

axis.
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Cursor 1, By using the Cursor 1 and Cursor 2 commands, you can set the respective
Cursor 2 cursor to the minimum and the maximum of a curve as follows:

1. Right-click a curve in the diagram.

2. Pointto Cursor 1 or Cursor 2, and then click Jump to Max or Jump to Min
to set the respective cursor to the maximum or the minimum of the curve.

Figure 10-9:
Setting the cursor 1 to Zoom Made
the maximum Optirize
Reset Axes
H-fixis »
f-fixis »
Cursor 1 3 Jurnp ko Min
Cursar 2 3 Jurnp ko Mazx
Copy
Copy with Settings .
Hint: If both traces are close together and are displayed in one diagram, it might
be difficult to select the curve you want to process. In this case, you can click
Always Two Diagrams, select the trace in the respective diagram, and then set
a cursor as described above. Then you can switch back to one-diagram display
by clicking Auto.
Hint: To set the cursor to a specific frequency, you can enter this frequency
directly in the frequency box next to the respective cursor.
Figure 10-10:
Setting the cursor 1to a Frequency Trace 1 Trace 2

frequency 10.700 MH2 30,838 dB -33.403 dB
11.300 MHz 90,898 dB 25,518 dB

delta C2-C1 £00.000 kHz -60.060 dB 7.885 4B

Copy from Zoom By clicking the Copy from Zoom | button you can copy the start and stop
frequencies of the zoom area to the sweep settings, keeping the number of
measurement points constant. This function is especially useful to measure a
detail of a curve with a higher resolution.

Note: The Copy from Zoom command is available once the Zoom Mode has
been activated.
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The following figure shows a zoom area of an measurement. Due to the low
number of measurement points within the area, the displayed curve is not
smooth.

Figure 10-11:
Measured curve with

ajurement.Bode

OMICRON Lab - Bode Analyzer Suite - NewBodel

initial sweep settings File Messurement Configuration  Calibration  Trace Tools  Help
DEH &SR as b @ o BEEEE
& User Calibration. . 7% Probe Calibration. . %z Trace Functions... TRL AWG OFF  TRZ AWG OFF T
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By applying the Copy from Zoom function the frequency span is narrower,
resulting in a higher resolution of the measured curve.

Figure 10-12:
Measured curve W|th OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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After using the Copy from Zoom function, the original sweep settings are lost.
If used, the User Calibration is switched off, too.

Hint: Compare the frequency sweep settings before (see Figure

10-11: "Measured curve with initial sweep settings" on page 132) and after
applying the Copy from Zoom function (see Figure 10-12: "Measured curve
with sweep settings copied from the zoom area" above).
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Special Zoom
Function

Figure 10-13:
Special zoom function
applied on Y-axis

Data and Memory

In the Zoom Mode, when moving the pointer over an axis the pointer becomes
a double-headed arrow. Then click the left mouse button to zoom in and the right
mouse button to zoom out respectively.
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Hint: This function is also available in the Gain/Phase mode and in the
Impedance/Reflection mode.

With the Bode 100 you can copy the current measurement data into the trace
memory and display it.
To store and display the measurement data:

1. Click the Datars Memory | button to store the current measurement data into
the trace memory.

2. In the Display list, select one of the following:
- Data to display the current measurement data
- Memory to display the stored measurement data

- Data/Memory to display the difference between the current and the
stored measurement data

- Data & Memory to display the current and stored measurement data as
two curves in the same diagram
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Hint: The Data/Memory option is particularly useful to compare two
electrical components of the same type because even smallest differences
in the frequency behavior can be detected easily.

Figure 10-14:
SeleCﬁng Display OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
function File  Measurement  Configuration — Calibration  Trace Tools  Help
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Example: Using the data and memory functions
Example duration: 15 minutes

In this example you will learn step by step how to use the data and memory
display function in the Frequency Sweep mode.

How to:
» Copy the current measurement data to the trace memory
» Compare the frequency responses

» Detect even smallest differences between the current and stored
measurement data by using the Data/Memory display function

Question: How does touching the housing of the quartz filter on the sample
PCB influence the measurement?
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To find out the answer, proceed as follows:

1. Follow steps 1 to 14 of the example outlined in 5.1 "Example: Frequency

Sweep Measurement” on page 52.

2. Clear the Trace 2 check box.
Your screen should now look like this:

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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3. Click the

[rata-»kemary

| button to store the measurement data.

136



Advanced Functions

4. In the Display list, select Memory.
The stored data is displayed as a dashed line.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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5. Inthe Display list, select Data & Memory, and then touch the housing of the
quartz filter (or even better the pins of the quartz) with your finger.
By doing this you shift the parallel resonance frequency of the filter.

6. Mark the new parallel resonance frequency with the cursor 1 by using the
Jump to Min function. Right-click the curve, pointto Cursor 1, and then click
Jump to Min.

Figure 10-15:

Setting the cursor 1 to Zoom Made

the minimum Optirize
Reset Axes
H-fixis

3

N7
[ o torin ]
3 Jurnp ko Mazx ‘
T
W

Copy
Copy with Settings : |

7. Now, you can measure the effect of touching the quartz filter by using the
delta C2-C1 function.
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Hint: Use the Zoom Mode function to get a better view. The figure below
shows a zoomed diagram showing the effect of touching the quartz filter's
housing.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode ‘ZHElE
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Result: Touching the quartz housing shifts the parallel resonance frequency
by 300 Hz. You might measure different values with your quartz filter.

8. In the Display list, select Data/Memory, and then touch the filter.
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9. Optimize the Y-axis.

The diagram now displays the difference between the actual measurement

data and the stored data.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode
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If the curve is above the 0 dB line the current measured data is higher than the
stored measurement data. If the curve is below the 0 dB line the currently
measured data is lower than the stored measurement data.

Hint: The Data/Memory function allows you to detect even smallest differences
between different parameters of the same component type (e.g. comparison of
two quartz filters of the same type).

Congratulation! You learned how to use the data and memory functions in the

Frequency Sweep mode.

How to:

» Copy the current measurement data to the trace memory

» Compare the frequency responses

» Detect even smallest differences between the current and stored
measurement data by using the Data/Memory display function
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10.2

Single Sweep

DUT Delay,
Measurement
Period

Figure 10-16:

DUT delay and
Measurement period
fields

Advanced Sweep Options

In all frequency sweep modes (-, ] and [&]), you can choose between

continuous sweep F and single sweep Ml measurements. In most
applications, it is recommended to use the continuous sweep measurement
since all measurement data is periodically updated.

You can use the single sweep Ml measurement to capture one-time events or
to produce a stable curve before using the Copy or Copy with Settings
function.

In the Configuration window, you can find the DUT delay and
Measurement period boxes.

Configuration g|
Device Configuration l Connection Setup ]
Measurement: % Gain/Phase " Impedance/Reflection
SOURCE Recei
" Auta RECEIVER 1 e RECEIVER 2
+ 0On
@ O I 1kHz  * L
ATTH 1 ATTH 2
20dE - DUT delay 20dE -
0.00s
E i Measurement
. period
Internal 3,06 ms
reference
500 D
L
Lewvel
ouTPUT
QK | Cancel | Help

The measurement period indicates the time the Bode 700 requires to perform
measurement at one frequency point. By multiplying this value with the selected
number of measurement points you can get an estimate of the expected sweep
time.
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Example: Expected sweep time for 401 points and a measurement period of
3.06 ms

sweep time = 3.06 ms * 401 frequency points =1.2's

Some devices under test require a settling time when the input frequency has
been changed (e.g. phase-locked loops). The DUT delay allows setting this
waiting time.

Let's assume our DUT requires a 10 ms settling time each time the input
frequency has changed. To allow for this waiting time, enter 10 ms in the DUT
delay box.

Figure 10-17:

Setting the DUT delay Configuration X
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20dB -
Internal T B
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SDQI:I
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The measurement period is automatically updated. When using the same
number of measurement points as before, the sweep time is now much longer.

sweep time = 13.06 ms * 401 frequency points = 5.23 s

Hint: Set the DUT’s delay to zero after your measurement is completed to
ensure the shortest sweep time possible for next measurements.
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Number of
Measurement
Points

Figure 10-18:
Entering the number of
measurement points

Sometimes a very specific number of measurement points is required. With the
Bode 100 you can set any number of measurement points in the range
2...16501. To set the number of measurement points, click in the

Number of Points box, and then enter the number of points you wish to use for
your measurement.
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To get back a predefined number of measurement points, select the
corresponding entry in the Number of Points list.

Figure 10-19:
SeleCtlng a Predeflned OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode ‘ZHElE‘
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10.3

Unwrapped Phase

The Unwrapped Phase function is available in all frequency sweep modes ([,
and [&). Usually the phase is displayed between +180° (+3.14159 rad). By
using the Unwrapped Phase function, you can display the phase continuously.
In some applications such as calculation of the phase delay times (for example,
for filters) an unwrapped, continuous display of the phase is very useful.

To activate the Unwrapped Phase function:

1. In the trace settings area of the Bode Analyzer Suite window, select the
Phase format.

¥ Trace 2[TR2)

Caolar _Z‘
Measurement ’m
Dizplay |Data -
Gona [roe] 3D
Ymax 181717

Ymin |-181.23°

Y-Seale: * Lin
" Log TR2
" LagITR2

[rata-»kemary |

Main | Advanced
2. Click the Advanced tab, and then select the Unwrapped Phase check box.

¥ Trace 2[TR2)

Unwrapped Phase
Urwiapped Phase W

[ 100.000kHz ™
[ #0.000MHz ™

Main  Advanced
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3. Optionally, you can activate the Unwrapped Phase function within a specific
frequency range. To do so, select the check boxes next to Begin and End,
and then enter the begin and end frequencies between which a continuous
phase is displayed.

Hint: Activating the Unwrapped Phase function within a frequency range is
especially useful when the phase is instable or noisy at the start frequency of

the sweep.
4. To display the wrapped phase again, clear the Unwrapped Phase check
box.
The following figures show a measurement with the wrapped and unwrapped
phase.
Figure 10-20:
Example of the wrapped
phase =20
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Figure 10-21:
Example of the
unwrapped phase
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10.4 Using the Trace Functions

The Bode Analyzer Suite provides the following trace functions for advanced
displaying of the measurement results in the Frequency Sweep mode:

e Average
¢ Min Hold
¢ Max Hold
You can control the trace functions in the trace functions area of the tool bar.
Figure 10-22:
Trace functions area of %y Trace Functions. . TR1 &G OFF TRZ AVG OFF %)
the toolbar ) )
To activate the trace functions:
1. Click the Trace Functions button s raceruncsns.. to open the
Trace Functions — Settings dialog box.
Figure 10-23:

Trace Functions - Trace Functions - Settings

Settings dialog box

Trace 1

+ Average
" Min Hald
" Max Hald

Trace 2

+ Average
" Min Hald
" Max Hald

Process Depth:

10 - Default

QK | Cancel | Help |

2. In the Trace Functions — Settings dialog box, select the trace function you
want to use.

3. Select the process depth to define the number of sweeps used for the
calculation of the selected trace function. The accuracy of the trace functions
increases with the process depth value.

4. Click OK.

You can reset all trace functions settings to the default values by clicking the
Default button.
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Hint: You can switch the trace functions on/off by clicking the TR1 AVG OFF
button | muserr for the corresponding trace. The first clicking of the

TR1 AVG OFF button wasorr starts the averaging. After that, clicking this
button toggles between the averaged curve and the current (not averaged)
sweep.

iz Trace Functions. .. (/[ TR1 AYG ON | PRz AVG OFF %‘)

V=2 W Trace1(TR1]

Caolar _Z‘
Measurement ’m
Dizplay ’m
Format ’W‘
rmax ’W

“min |-100.00 dB

Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

Main | Advanced

The averaging indicator in the status bar shows how many sweeps are currently
used for the averaging.

Table 10-1:
Averaging indicator
Averaging Indicator Description
[2o TRt ot | 1 out of 10 sweeps is so far used for averaging.
[g TRt o510 | 5 out of 10 sweeps are so far used for averaging.
[Bg TRL: 10710 | 10 out of 10 sweeps are used for averaging.

By clicking the Reset Trace Functions button %}, you can set the number of

sweeps used to calculate the Average, Min Hold, and Max Hold trace functions
to zero — this restarts the trace function process. The Reset Trace Functions
button %) resets the number of used sweeps for both traces.
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The trace function indicator in the status bar can show four different statuses:

Table 10-2:
Trace function indicator
Trace Function Indicator | Description
[TRT: GO Trace function is switched off.
A5 TRI: 10/10 Average trace function is used.
ALTRL 10j10 | Min Hold trace function is used.
T TRI: 1010 Max Hold trace function is used.

10.4.1 Average

By using the Average trace function of the Bode 100, you can reduce noise and
remove stochastic events. Usually narrow receiver bandwidths are required to
reduce the noise in a measurement, leading to long sweep times. Alternatively,
you can use a wide receiver bandwidth and reduce the noise by averaging the
measurement results over several sweeps. The noise reduction increases with
the number of sweeps over which the measurement results are averaged.

The Average trace function displays a curve averaged over a defined number
of sweeps. The measurement results are averaged in the complex plane. Each
data point is a vector described by its real and imaginary part. The averaged
curve is calculated at each data point as the vector sum of the measurement
results obtained during the sweeps divided by the number of the sweeps:

n

Givg = = (Eq. 10-1)

where the process depth n can be set between 1 and 99 or to the infinite value
(see 10.4.4 "Setting the Process Depth to Infinity" on page 155).
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Example: n =10
First sweep [2omri oy [: The displayed curve after the first sweep is the current
measurement.

Gyg = Gy

(Eq. 10-2)
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Fifth sweep [a s osi0 [ The displayed curve is a curve averaged over the first
five sweeps.
5
G,

G 1y = (Eq. 10-3)
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Tenth sweep and up [a oy |- The displayed curve is a curve averaged over
the last ten sweeps.

G, =i=1_ (Eq. 10-4)
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fiHz
TR1: Mag(Gain) Export Traces Data...

O TR1: 10010

Hint: As soon as the defined process depth n (in this example 10) is reached,
the last n sweeps are used for the calculation of the averaged curve.
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10.4.2 Min Hold

If the Min Hold trace function is activated, the Bode Analyzer Suite displays the
minimum of the selected output format. For example, if the Imaginary output
format is selected for the Gain measurement, the minimum imaginary part of the
defined number of sweeps is displayed.

Color NN - |
Measurement | Gain hd

Dizplay |Data -

Format | Imag - .

‘maw |5.00

“min |-5.00

Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

(Eq. 10-5)

Imag(G min;_ ; (Imag(G,))

min) -

Hint: The Min Hold and Max Hold trace functions refer always to the selected
output format.

10.4.3 Max Hold

If the Max Hold trace function is activated, the Bode Analyzer Suite displays the
maximum of the selected output format. For example, if the Imaginary output
format is selected for the Gain measurement, the maximum imaginary part of
the defined number of sweeps is displayed.

Imag(G max;_,; ,(Imag(G),)) (Eq. 10-6)

max) =
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The following figure shows the maximum and the minimum of the same
measurement.

OMICRON Lab - Bode Analyzer Suite - C:\Documents and Settings\BerBau0O0\Desktop\BodeTestSetting.Bode

File: Measurement Configuration Calibration Trace Tools Help
DEHdaERasbHes @ ¢ BEEEE
& User Calibration. .. % Probe Calibration. . T Trace Functions. ., TR1 MAX ON | TRZ AvG OFF X))

Frequency Trace 1 Trace 2 F Tiacel (TR1)

Color
delta C201 Measwement [Gan -]
‘ Display e
Fomal [MagleB) <]
=0 Ymay [275408
min [121.97 dB

40 ¥Scale & Lin
© Log TR
© Log[TRII

50 Datar>Memory
Main | Advanced|

o \
\ I~ Tiace 2(TR2)
\

TR1/dB
3
£
=
_Pk‘ ”"?
%—
=
e =
Ty
_,?
%-
=
= =

‘L"‘L “| “‘ﬁ\ (‘ llh N ,m
= ,',NH‘ I} i j'\ I 1 “||~
"J;‘"'l" “”“”i:-:%‘n I"}.” i“ | 'MH I | ";‘ ‘ ?
i | i
o “”‘! ' 1|h| ‘” )M ‘MI V*l‘ l |IIH .
i “H-:\ | LR L oy |
10 ! | : Man [Bdvarced]
! Diagram Setup
-120 o
9.5M 10.0M 10.6M 11.0M 11.6M 12.0M B
fiHz
TR1: Mag(Gain) e m—— TR1{Memory): Mag(Gain) Export Traces Data. ‘

TR1: 10{10
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10.4.4 Setting the Process Depth to Infinity

To set the process depth to infinity, select Infinity in the Trace Functions —
Settings dialog box.

Figure 10-24:

depth to |nf|n|ty race Functions - settings

Trace 1

" Average
" Min Hald
* MaxHald

Trace 2

" Average
" Min Hald
* MaxHald

Process Depth:

Infirity - Drefault

QK | Cancel | Help |

If you set the process depth to infinity, special incremental algorithms are used
for calculating the Average, Min Hold and Max Hold trace functions. The
advantage of these algorithms is that not all sweeps have to be stored for
calculation. The following table shows how the algorithms work for different trace

functions.
Trace Function Description
Average The incremental averaging works up to over two
billion sweeps.
Min Hold/Max Hold The Min Hold and Max Hold trace functions

always show the minimum or maximum of all so
far measured sweeps without limitation.

The Min Hold and Max Hold trace functions work
for the measurement format selected at the time
the respective trace function was activated. If the
measurement format is changed the trace
function is reset and starts again with a new first
sweep.
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The following table shows how the process depth set to infinity is indicated.

Averaging Indicator

Description

A TR1: 26fo

If the number of sweeps is less than 100, the
current number of sweeps is displayed.

O TR1: oofom

If the number of sweeps is greater than 99, the
infinity symbol is displayed.

10.5 Y-Axis Scaling

In all frequency sweep modes (E, and @), you can select the linear or the
logarithmic scaling of the Y-axis. You can select the scaling of the Y-axis
separately for each trace in the Trace menu.

Figure 10-25:
Setting the Y-axis
scaling

¥ Trace1[TR1)

Caolar _Z‘
Measurement ’W‘
Dizplay ’m
Faormat ’m
Ymax |306.23 mOhm

Ymin |-294.44 mOhm
Y-Seale: * Lin
" Log TR
" LagITR1I

[rata-»kemary |

Main | Advanced
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The default setting for the Y-axis scale is linear (Lin). If measurement curves
contain very low and very high values, it is difficult to get a good impression
about the curves characteristic for the low values. As an example of such a
curve, the following chart shows the imaginary part of an inductance dominated

by a resonance around 360 kHz.

10000

TR1/Ohm
°
N

-10000
\
Y-Seale: * Lin
" Log TR
" LagITR1I

TR1: Imag(Impedance)
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By switching to the logarithmic scaling (Log TR1), the characteristic provides a
much better view on the inductor’s behavior below the resonance frequency.

10t Log Y-Scale:'Neg. valuesin TR 1' /‘.

TR1/0hm

/ .
107 10% 10° 10 10° 10° e -Scale: Lin
* Log TR

TR1: Imag(Impedance) " LogITR1|

Since negative values cannot be displayed in a logarithmic scale, the curve will
show gaps wherever negative measurement values are present. The presence
of negative values is indicated by a warning message in the upper left corner of

the frequency curve.

maGog Y-Scale: 'Neg. values in TR D
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To display the measurement curve without gaps in the logarithmic scale, you
can display the absolute values of the measurement (Log |TR1|).

TR1/0hm

10° 10° 102 104 105 o= 07 Y-Seale: O Lin
fiHz " Lag TR1
@+ LogITR1|

TR1: Imag(Impedance)

Hint: If the imaginary part of a DUT is displayed with the Log |TR1]| scaling, a
rising flank of the curve indicates an inductive behavior of the DUT while a falling
flank indicates a capacitive behavior.
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10.6

Figure 10-26:
Setting the Impedance
measurement

RLC-Q Sweep

The RLC-Q Sweep function is available for all frequency sweep modes (B,
and @). By using the RLC-Q sweep function, you can display frequency swept
curves for the serial and parallel equivalent circuits of the DUT. For the
definitions of the equivalent components used in this section, see

4.1.2 "Equivalent Circuits" on page 37 and 4.1.3 "Quality Factor" on page 39.

For the Impedance measurement, the following quantities can be displayed:
+ Series resistance R, in Ohms
+ Series inductance L, in Henry

 Series capacitance C, in Farad

+ Q factor
¥ Trace1[TR1)
color NN - |
(  Measurement |Impedance;
Dizplay |Data hd
Faormat |kag -
rmax Mag
Mag(dB)
‘min |Phase(’]
Fhase(rad]
-Scale: |Polar
Real
Imag
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The following frequency characteristic shows the series inductance L, of an
inductor under test.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help

NEHED s H[E] @ e HEEE

& User Calibration. . %, Probe Calibration. . Ry, Trace Functions... TR1AWG OFF TR2 AVG OFF X))
Frequency Trace 1 Trace 2 % Tiace 1 (TAT]
574545 Hz 2339 mH
1062777 MHz ENEETD) coor [N ~|
dehal20l  10BIA0E MHZ Y Messusment [Impedance =
[ | Display [Data S
Format |Ls -
7m
mss [724wH
i |-5.60 mH
&m frmin BT
-Scale: & Lin
}l  Log TR1
5m | © LogITRI
|‘ Data->Memary
am
/ i
3m va I~ Trace 2(TR2)

TR1MH

0

o
—
[ i

2m |
|
-3m | Main
|
| Diagram Setup
-4m ‘ -
\J o
5m
Export Traces Data.
10! 107 10% 10+ 10% 10% 107
fHz

=—— TR Ls(Impedance)

[ TRL: AVG O [ TRz OFF

Hint: Negative readings in Henry (see cursor 2) indicate that the inductor under
test shows capacitive behavior at the respective frequency.
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For the Admittance measurement, the following quantities can be displayed:
» Parallel resistance R, in Ohms

» Parallel inductance L, in Henry

» Parallel capacitance C, in Farad

+ Q factor

Figure 10-27:
Setting the Admittance WV Trace1(TR1)

measurement
color NN - |
C Measurement Admittancel_.D

Dizplay |Data j

Faormat |kag -

Mag
Mag(dB]
‘min |Phase(’]
Fhase(rad]
-Scale: |Polar

Real

rmax

L
Data [;lpj

Main | Advanced
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The following frequency characteristic shows the parallel capacitance C, ofa
10 nF foil capacitor.

OMICRON Lab - Bode Analyzer Suite - NewBodeMeasurement.Bode

Fle Measurement Corfiguration  Calbration  Trace  Tools  Help

NEHED s H[E] @ e HEEE

%, Probe Calibration. .

IMP OFF - Xy, Trace Functions. .. TRI1 AWG OFF  TRZ2 AWG OFF )_9

& User Calibration. .
Frequency Trace 1 Trace 2 ¥ Trace(TRT]

£ 673533 MHz 5504 nF
31,086 kHz 10.159 nF coor [N ~|
deba 201 6547508 MH: 16663 nF Measuement [Admitance =]
vl Display [Data =
Fomat [Cp =]
mss [45:30 F
|\ Viin [4453nF

40n
YScale: & Lin
|  Log TR
© LogITRI

30n I
| Data->Memary

I Main

| ™ Trace 2(TRZ)

0

=
E o, [
, —=
—
[ i

-20n
Main

-30n Diagram Setup
|| €
V -
-40n
Export Traces Data...
10°% 10* 10% 10% 10
fiHz

TR1: Cp(Admittance)
[ o [ oF
Hint: Negative readings in Farad (see cursor 1) indicate that the capacitor under
test shows inductive behavior at the respective frequency.
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10.7 Level Shaping

By using the Shaped Level function available in all frequency sweep modes
(B, I8 and [&]), you can vary the Bode 100 output level within the frequency
sweep range. Possible applications for this functionality include:

» Avoiding nonlinearities during Control Circle analysis (e.g. of DC/DC
converters)

» Reduction of noise or avoiding overloads for circuits showing a high dynamic
variation of gain within the frequency sweep range

To activate the Shaped Level function:

1. In the Configuration area, click the Level arrow, and then click
Shaped Level.

Figure 10-28:
Select the Configuration
Shaped Level function Level E [ ooodem
Lewvel 20 dB -
Shaped Level
20 dB -
Receiver Bandwidth |1 kHz hd
2. Click the Shaped Level button.
Figure 10-29:
Open the Configuration
Shaped Level window Shaped Level El 0.00 dBrm
Altenuator CH1 |20 dB hd
Altenuator CH2 |20 dB hd
Receiver Bandwidth |1 kHz hd
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In the Shaped Level window, enter the frequencies and the delta output levels
in dB relative to the reference level. In the Output Level column, the calculated
output levels are displayed.

Figure 10-30:

Enter frequencies and Shaped Level X

delta levels —
File  Tools  Help

@ oK ’ Cancel | £28 Print Q Print Preview @

Output Level
Reference Level 0.00 dBm
Frequency Delta Level Output Level
20.000 kHz 5.00 4B 5.00 dBm @
100.000 kHz -15.00 dB -15.00 dBm ||
3 180,000 kHz sonde [ 5.00dBm ®

Preview Output Level

BOK 100K 150K
fiHz

The green indicators next to the Output Level column signal that the output
level is within the Bode 100 output level range (-27 dBm...13 dBm). If an
entered delta level results in an output level outside the Bode 700 range, the
output level is limited accordingly. The output level limiting is signaled by a red
indicator (see the following figure).
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You can shift the output level frequency characteristic up or down by changing
the reference level in the Reference Level box.

Figure 10-31:

Change reference level Shaped Level E|

File  Tools  Help
@OK ’Cancel Lo Print @Print Preview @

Output Level
Reference Level
Frequency Delta Level Output Level
20.000 kHz 5.00 4B 13.00 dBm @
100.000 kHz -15.00 dB -5.00 dEm @)

180.000 kHz

Preview Output Level

BOK 100K 150K
fiHz

Hint: Based on the entered delta level the calculated output levels at 20 kHz and
180 kHz are outside the level range of the Bode 100. Therefore the values are
limited to the maximum possible output level and the red indicators are
activated.
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You can shape very steep slopes by entering two delta levels at the same
frequency. To select either the rising or falling edge, adjust the sequence of the
delta levels:

1. Click in the respective frequency cell.

2. Right-click in the selected frequency cell, and then click Set as First or
Set as Second.

Figure 10-32:
Original characteristic Shaped Level [z|

File  Tools  Help
9 oK 3 Cancel | EiPrint [J) Print Preview | @

Output Level
Reference Level 0.00 dBm
Frequency Delta Level Output Level
10.000 kHz 5.00 dB 5.00 dBm @
40.000 kHz -10.00 dB -10.00 dBm )|
50.000 kHz -5.00 dB -5.00 dEm @)
100.000 kHz .00 dB 6.00 dBm @
» -13.00 4B -13.00 dBm )|
* I Set as First

Preview Output Level

-20

BOK 100K 150K
fiHz

The figure shows the output level frequency characteristic before clicking
Set as First.
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Figure 10-33:
Characteristic with
changed slope

X

Shaped Level
File  Tools  Help
@ oK M Cancel | EdPrink gPrint Presiew | @)

Output Level
Reference Level 0.00 dBm
Frequency Delta Level Output Level
10.000 kHz 5.00 4B 5.00 dBm @
40.000 kHz -10.00 dB -10.00 dBm )|
50.000 kHz -5.00 dB -5.00 dEm @)
100.000 kHz £.00 dB 6.00 dBm @

-

-13.00 dB -13.00 dBm @)

Preview Output Level

BOK 100K 150K
fiHz

The figure shows the output level frequency characteristic after clicking
Set as First.
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10.8 Source Control

The Bode Analyzer Suite provides control of the Bode 700 output source. With
this function, you can switch the output source on and off. The source control is
useful if, for example, some sensitive measurement objects should not be
permanently exposed to the output signal of the Bode 100.

To access the source control:

1. Click Device Configuration on the Configuration menu or the
Device Configuration toolbar button %, to open the Configuration

window.
Configuration Pz|
Device Configuration l Connection Setup ]
Measurement: % Gain/Phase " Impedance/Reflection
SOURCE Fimae
; g:‘“ RECEIVER 1 B:ﬁdexﬂth RECEIVER 2
@ o I 1 kHz = I
ATTH 1 ATTH 2
20dE - DUT delay 20dE -
0.00s
E i Measurement
Nl period
Internal 306 e
reference
500 D
]
Lewvel
ouTPUT
QK | Cancel Help
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2. In the Configuration window, select one the following options:

Table 10-3:
Source control options

Source Control Option |Description

On (default) The output source is always on.
Off The output source is off.
Auto The output source is switched on only during a

measurement ( I or Ml.).
The output source is switched off immediately

after a measurement is stopped (@ ).

The source status is indicated in the status bar of the Bode Analyzer Suite
window.

Diagram Setup
{v

I

17TM 18M

Export Traces Data...

The following table shows the source status as indicated in the status bar of the
Bode Analyzer Suite window.

Table 10-4:
Source control indicator

Source Control Indicator | Description

The output source is on.

Saurce: On

Source Oiff The output source is off.

The source output is on, a measurement is
currently performed.

The source output is off but will be immediately
switched on when a measurement is started.

Source: Auto

Note: If the output source is switched off no measurements can be performed.

170



Advanced Functions

10.9 Using Probes

With the Bode 100 you can use measurement probes for channel 1 input and
channel 2 input.

Figure 10-34:
Using a probe

Quartz Filter

Using the probes is recommended in the following applications:

» Measurements at points within the DUT circuitry not accessible with BNC
cables

* Measurements of devices under test which are sensitive to capacitive or
resistive influences (e.g. resonant circuits)
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Figure 10-35:
Setting the probe ratio

When using a probe, consider the following instructions:

1. Always set the correct probe ratio in the Connection Setup tab of the

Configuration window.

You can choose between 1:1, 10:1 or 100:1.

Configuration

Device Configuration  Connection Setup l

-

Two Port DUT

One Port DUT

Channel 2 External Probe

3

or Probe

Help
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2. For correct probe operation switch the input impedance of the channel
connected to the probe to high impedance (1 MQ).

Figure 10-36:
Setting high input
impedance of channel 2

X

Configuration

Device Configuration l Connection Setup ]

Measurement: % Gain/Phase " Impedance/Reflection

SOURCE Receiver
r(: ’S”m RECELER Banduwidth RECEIVER 2
* On

@ o I 1 kHz = I

ATTH 1 ATTH 2

%7 20de - DUT delay 20dE -

000s

Measurement

Nl period

Internal 306 e
reference )

SDQI:I

Lewvel

——

ouTPUT

QK | Cancel | Help

3. Ensure that your DUT is terminated correctly.

Hint: When using a probe with a DUT which requires a 50 Q termination, you
can simply connect the BNC 50 Q2 load delivered with your Bode 100 to the
output of the DUT.

4. To obtain accurate measurement results, calibrate the Bode 7100 as follows:

5. Connect the ground of the probe with the ground of the DUT and touch the
DUT’s input with the probe tip.

6. Now, perform the calibration in the Gain/Phase mode as described in
3.3 "Example: Gain/Phase Measurement" on page 26.
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Figure 10-37:

Touching the DUT’s

input with the probe’s tip
Hint: Ensure that the probe’s tip is in contact with the DUT’s input all the time
until the calibration is finished.

7. After having calibrated the probe, start your measurement at any point of the
DUT using the probe.
\ / Congratulation! You learned how to use the advanced functions of the
D Bode 100.

How to:

* Use the advanced display functions like Zoom and Copy to Clipboard
+ Use the advanced sweep options

» Use the level shaping functionality

+ Use probes

The first time | used my
measurement probe to
zoom into an electrical
circuit will always

remain in my memory.
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11 Automation Interface

So far you have worked with the Bode 700 by using the graphical user interface
(GUI) of the Bode Analyzer Suite. Beside this very comfortable user interface for
laboratory use, the Bode 100 provides also an all-purpose application
programming interface (API) for interfacing with the Bode 100.

The Bode Analyzer Automation Interface supports OLE automation and allows
quick access of the Bode 100 using OLE compatible controllers such as Excel®
or programming languages like Visual C++®. This allows simple integration of
the Bode 100 into automated measurement setups. Additionally, by using the
Bode Analyzer Automation Interface you can directly control the Bode 100 with
programs such as LabVIEW and MATLAB.

The Bode Analyzer Automation Interface is automatically installed during the
Bode Analyzer Suite installation and is available for use as soon as a Bode 100
unit is connected to your computer. (You do not need to start the

Bode Analyzer Suite to access the Bode Analyzer Automation Interface).

Figure 11-1: "Object hierarchy overview" on page 176 shows an overview of the
command structure for the Bode Analyzer Automation Interface.

Note: An overview on the measurement functions available through the Bode
Analyzer Automation Interface is provided in the Automation Interface Object
Hierarchy and in the Automation Interface Reference. Both documents are
located in the Automation subdirectory in the Bode Analyzer Suite directory. You
can find detailed information how to access this directory on page 177.
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Figure 11-1:

Object hierarchy ‘
overview

Bodeapplication ‘

:

Docum ent
(Bodebocument )

4{

Devices
{DeviceCollection)

H

Dewvice ‘

DeviceSetup
(DeviceSettings)

|

Channels
{ChannelCollection )

Receivers
(ReceiverCollection)

Sources
(SourceCaollection)

%

Measurements
{Measurem entCaollection)

H

Measurement ‘

UsercCalibration ‘

Calibration

ProbeCalibration ‘

SingleFrequencyGainPhaseSettings

SingleFreguencylm pedanceSettings

SweepFreguencySettings

Measurernst
Settings

SweepExtCouplerFrequencySettings

I R

SweeplmpaAdapterFrequencySettings

H

4{
<‘

Results

{ResultCollection) Result

Hint: You can find a detailed overview of the Bode Analyzer Automation
Interface object hierarchy in the Automation subdirectory of the
Bode Analyzer Suite directory.

Figure 11-2: "Example of code segment for accessing the Bode Analyzer
Automation Interface" on page 177 shows a typical code segment used to
access functions of the Bode Analyzer Automation Interface. In this example, a
Bode 100 unit is searched for and, after a device has been found, measurement
parameters are set.
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Figure 11-2:
Example of code
segment for accessing
the Bode Analyzer

. Public Sub Main()
Automation Interface Dim myBodelpp As New BodeAnalyzer.BodeApplication

Dim myDocument As BodeAnalyzer.BodeDocument
Dim mySelectedDevice A3 BodeRnalyzer.Device

= Example

Visual Basic

Set myDocument = myBodeApp.Document
myDocunent . Devices. ScanForDevices

If myDocument.Devices.Count > 0 Then
' select the first device
myDocument. Devices (1) .SelectEndInit
' set default device settings
myDocument.SelectedDevice.DeviceSetup.Bandwidth = Bandwidth Hz100
myDocument.SelectedDevice.DeviceSetup.DUTDelay = 0.000012 ' 12 ps
myDocument.SelectedDevice.DeviceSetup.Channels (2) .Termination500hm = True
myDocument.SelectedDevice.DeviceSetup.Channels (2) .Probe = ExternalProbe ProbelQtol
myDocunent. SelectedDevice. DeviceSetup.Receivers (1) .Attenuator = Attenuator_dB0
myDocument. SelectedDevice. DeviceSetup.Receivers (2) .Attenuator = Attenuator_dBl0
myDocument.SelectedDevice.DeviceSetup.Sources.Level = 20 ' 20 dBm aren't possible, is changed to 13dBm (max. Level)
myDocument. SelectedDevice . DeviceSetup.Sources (1) .0n = True
myDocument.SelectedDevice.DeviceSetup.Sources(2).0n = False

Set mySelectedDevice = myDocument.SelectedDevice
MagBox " e (Id: " & mySelectedDevice.Devicel
ySelectedDevice.Seriallumber & ") sele

Else
' No device connected
MagBox “lio
End

End If

myBodeApp.Quit
End Sub

= See Also

Device Members

For a complete description of the Bode Analyzer Automation Interface, see the
Bode Analyzer Automation Interface Reference. To access it:

1. On the taskbar of your Windows® operating system, click the Start button,
and then point to Programs.

2. Point to Bode Analyzer Suite, point to Automation, and then click
Automation Interface Reference.

Congratulation! You learned:
» Basics of the Bode Analyzer Automation Interface

» About the object hierarchy of the used command structure

*  Where to look for further information on the Bode Analyzer Automation
Interface

Shout "OLE" to
celebrate your new
knowledge about the
Bode Analyzer
Automation Interface.
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12 Troubleshooting

12.1 USB Cable and/or Power Supply to the
Bode 100 Is Missing

If the serial number field in the status bar displays No Device on red background
then the Bode Analyzer Suite does not communicate with the Bode 100.

¥ ] Solution: Connect the USB cable to the computer and the Bode 100 and check
the power supply. Then click the Search and Reconnect Device toolbar
button & to connect the Bode 100 with the computer.

12.2 Lost Communication

The loss of the power supply and other events can cause loss of communication
between the Bode 100 and the computer. In this case, the serial number field in
the status bar displays No Device on red background.

¥ ] Solution: Click the Search and Reconnect Device toolbar button B3 to
connect the Bode 100 with the computer.

12.3 Cannot Select Frequencies Lower Than 10 Hz

To activate the extended frequency range of 1 Hz...40 MHz, click Options on
the Tools menu, click the Measurement tab, and then select the
Measurement Range 1 Hz - 40 MHz option (see 9.2 "Setting the Measurement
Range" on page 120).

Note: The activation of the measurement range of 1 Hz...40 MHz will increase
calibration times including the internal calibration performed at the startup and
each time you reconnect to the Bode 700.
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Table 13-1:

Technical Data

13 Technical Data

13.1 Bode 100 Specifications

Bode 100 specifications

Characteristic Rating
Frequency range 10 Hz...40 MHz or
(selectable by the 1 Hz...40 MHz

Bode Analyzer Suite) (extended frequency range)
OUTPUT connector

Output impedance 50 Q

Connector BNC

Wave form Sinusoidal signal

Output voltage 0.01...1 Vrms into 50 Q load

—27 dBm...13 dBm

INPUT CH 1, INPUT CH 2 connectors

Input impedance

Low or high impedance selectable

Low impedance

Input impedance 50 Q

High impedance

Input impedance 1 MQ +2%
Input capacitance 40...55 pF

Connectors

BNC

Receiver bandwidth

1 Hz, 3 Hz, 10 Hz, 30 Hz, 100 Hz,
300 Hz, 1 kHz, 3 kHz

Input attenuator

0dB, 10dB, 20 dB, 30 dB, 40 dB

Input sensitivity

100 mV full scale
for input attenuator 0 dB

Dynamic range

> 100 dB at 10 Hz receiver bandwidth

Gain error

< 0.1 dB (calibrated)

Phase error

< 0.5° (calibrated)

USB interface

Connector

‘Type B
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13.2 Power Requirements

Table 13-2:
Power requirements

Characteristic

‘ Rating

AC power adapter

Input voltage/frequency

‘100...240V/47...63 Hz

DC power supply

Output voltage/output power +10...24V /10 W
Inner connector +10...24V

Outer connector Ground

Inner diameter 2.5 mm

Outer diameter 5.0 mm

13.3 Absolute Maximum Ratings

Table 13-3:
Absolute maximum
ratings

Characteristic

‘Absolute Maximum Rating

DC power input

DC supply voltage

+28 V

DC supply reverse voltage
(device does not work)

-28V

INPUT CH 1, INPUT CH 2 connectors (high impedance)

Maximum AC input signal

50 Vrms for 1 Hz...1 MHz

30 Vrms for 1 MHz...2 MHz

15 Vrms for 2 MHz...5 MHz

10 Vrms for 5 MHz...10 MHz
7 Vrms for 10 MHz...40 MHz

Maximum DC input signal

50 V

INPUT CH 1, INPUT CH 2 connectors (low impedance)

Maximum input power ‘ 1W (=7 Vrms)
OUTPUT connector
Maximum reverse power ‘0.5 w
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13.4 System Requirements

Table 13-4:
Computer requirements
Characteristic Requirement
Minimum configuration Pentium 1 GHz
512 MB RAM

Super VGA (1024x768) or higher-resolution
video adapter and monitor

CD-ROM drive

USB 1.1 or USB 2.0 port

Recommended configuration | Pentium 2.5 GHz or higher

1 GB RAM or higher

Super VGA (1024x768) or higher-resolution
video adapter and monitor

CD-ROM drive

USB 2.0 port

Operating system Windows® XP (32-bit and 64-bit),
Windows® Vista (32-bit and 64-bit),
Windows® 7 (32-bit and 64-bit)

13.5 Environmental Requirements

Table 13-5:
Environmental
requirements Characteristic | Condition Rating
Temperature Storage -35...4+60°C / -31...+140 °F
Operating +5...440°C / +41...4104 °F
For specifications |23 °C +5°C /73 °F £+ 18 °F
Relative humidity | Storage 20...90 %, non-condensing
Operating 20...80 %, non-condensing
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13.6 Mechanical Data

Table 13-6:

Mechanical data
Characteristic Rating
Dimensions (w x h x d) 26 x5 x26.5cm/10.25" x 2" x 10.5"
Weight <2kg/4.41Ibs

Hint: You can find more technical data on the OMICRON Lab Web site
www.omicron-lab.com.
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Contact Information / Technical Support

Contact Information / Technical
Support

E-Mail: support@omicron-lab.com

Web: www.omicron-lab.com

or contact the following OMICRON electronics customer service centers:

Europe, Africa, Middle East

OMICRON electronics GmbH
Oberes Ried 1
A-6833 Klaus, Austria

Phone: +43 5523 507-333
Fax: +43 5523 507-999

Asia, Pacific

OMICRON electronics Asia Ltd.
Suite 2006, 20/F, Tower 2

The Gateway, Harbour City
Kowloon, Hong Kong S.A.R.

Phone: +852 2634 0377
Fax: +852 2634 0390

North and South America

OMICRON electronics Corp. USA
12 Greenway Plaza, Suite 1510
Houston, TX 77046, USA

Phone: +1 713 830-4660 or 1 800 OMICRON
Fax: +1 713 830 4661

Alternatively, visit our Web site www.omicron-lab.com for customer service
centers in your area.
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